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About This Guide

This guide explains how to install and configure the Identity Manager Driver for SAP* HR. It 
contains the following sections:

Chapter 1, “Introducing the Identity Manager Driver for SAP HR,” on page 11
Chapter 2, “Installing the Driver,” on page 19
Chapter 5, “Understanding ALE Technologies,” on page 37
Chapter 6, “Configuring the SAP System,” on page 41
Chapter 7, “Understanding the Default Driver Configuration,” on page 55
Chapter 10, “Troubleshooting the Driver,” on page 89
Appendix B, “Example XML Document Received from the Driver,” on page 113
Appendix C, “Driver BAPIs,” on page 115
Appendix D, “Subscriber Change Modes and Validity Date Modes,” on page 119

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with Novell Identity Manager. Please use the User Comments feature at the bottom of each 
page of the online documentation, or go to http://www.novell.com/documentation/feedback.html 
and enter your comments there. 

Documentation Updates

For the most recent version of this document, see the Drivers Documentation Web site (http://
www.novell.com/documentation/idm35drivers/index.html).

Additional Documentation

For documentation on using Identity Manager and the other drivers, see the Identity Manager 
Documentation Web site (http://www.novell.com/documentation/idm35).

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
within a cross-reference path.

A trademark symbol (®, ™, etc.) denotes a Novell® trademark. An asterisk (*) denotes a third-party 
trademark.
About This Guide 9

http://www.novell.com/documentation/idm35drivers/index.html
http://www.novell.com/documentation/idm35
http://www.novell.com/documentation/idm35
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1Introducing the Identity Manager 
Driver for SAP HR

The Identity Manager Driver for SAP Human Resources (HR), subsequently referred to as the 
driver, creates an automated link between the SAP HR database and the Identity Vault. This 
technology enables data flow within a business enterprise based on its own unique requirements, and 
eliminates the labor-intensive and error-prone practice of re-entering the same data into multiple 
databases. As new records are added, modified, or deactivated (disabled) in SAP, network tasks 
associated with these events can be processed automatically. 

Because the SAP HR system is the authoritative source of personnel information, the driver allows 
administrators to propagate this data to other non-SAP business applications and databases without 
the need for custom integration solutions. Administrators can decide what data will be shared and 
how data will be presented within their enterprises. 

1.1  Understanding Driver Concepts
The driver is a bidirectional synchronization product between SAP R/3 HR systems and the Identity 
Vault. This framework uses XML to provide data and event transformation capabilities that convert 
Identity Vault data and events into SAP HR data and vice-versa. 

The Identity Vault acts as a hub, with other applications and directories publishing their changes to 
it. The Identity Vault then sends changes to the applications and directories that have subscribed for 
them. This results in two main flows of data: the Publisher channel and the Subscriber channel. 
Introducing the Identity Manager Driver for SAP HR 11
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1.1.1  Publisher Channel
Figure 1-1   Publisher Channel Process

The SAP R/3 HR database publishes information in the form of HRMD_A IDocs using Application 
Link Enabling (ALE) technology. The driver is only interested in HRMD_A Message IDocs. Any 
object type in these IDocs can be mapped to an eDirectory object type and subsequently 
synchronized. The driver consumes the IDoc files and converts the data into XML format.

The Publisher channel polls the SAP HR database for changes, and then submits XML-formatted 
changes to the Metadirectory engine for publication into the Identity Vault. The engine processes the 
document by sequentially applying all configured policies based on standard driver process flow.

The driver can then manipulate the information using various policies and filters defined by the 
system administrator. The driver then submits the data to the Identity Vault. Using eDirectory and 
other Identity Manager drivers, the data can be shared with other business applications and 
directories. Based on business rules, these other applications can add additional data that can in turn 
be inserted back into the SAP HR database using Business Application Programming Interface 
(BAPI) technology. 
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1.1.2  Subscriber Channel
Figure 1-2   Subscriber Channel Process

The Subscriber channel receives XML-formatted eDirectory events from the Metadirectory engine. 
The driver then converts these documents to an appropriate data format, and updates SAP via the 
BAPI interface. 

The Identity Vault sends changes only to the applications that have subscribed to receive them. 

1.2  Benefits
As the following examples illustrate, the driver enables you to automate and maintain business 
processes:

Automatically create an eDirectory account when an individual is hired.
Automatically delete or deactivate eDirectory accounts when an employee is terminated.
Synchronize bidirectional data between SAP and eDirectory.
Maintain accurate and consistent eDirectory IDs.
Define password policies (for example, a birthdate, social security number, and first and last 
name combinations).
Allow seamless integration between SAP and multiple applications (for example, eDirectory, 
Lotus Notes*, Netscape*, Exchange, and Active Directory*) using Identity Manager and 
eDirectory.
Create other eDirectory objects associated with a SAP object (for example, account codes or 
department records).

You can configure SAP and the Driver objects to enhance your organization’s business processes. 
Before installing and configuring the driver, you evaluate and define those processes. During 
installation, you configure the driver’s policies to automate these processes wherever possible. 

For more information about Identity Manager, refer to the Novell Identity Manager Administration 
Guide  (http://www.novell.com/documentation/idm/index.html).
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1.3  Driver Features
The following section contains information about the driver’s features.

Publisher Channel event status processing

The Publisher channel treats each object in an IDoc as a unique event. The status of each event 
determines the appropriate IDoc filename extension. For example, all events with a Warning 
status are placed together in a file with the .warn extension.
Publisher Channel Only configuration options
The Publisher Channel Only option in the driver’s parameters enables connectivity to a SAP 
host for read and query operations. The driver vetoes any subscription modifications sent to the 
SAP system if this option is selected. 
Publisher Connection option
This option informs the driver whether or not Publisher channel connectivity to the SAP system 
is desired. 
Publish History Items
This option specifies whether the driver returns data values that no longer have a current 
validity period.
Future-dated IDoc processing
Future-dated IDoc processing implements a stale event data check. When future-dated events 
are processed, the driver attempts to confirm the validity period of the event. If no matching 
validity period is found for the event data, the IDoc data is considered stale and is not applied. 
Validity checking can only be accomplished if SAP system connectivity is established through 
configuring the driver’s authentication parameters. Publisher Channel Only drivers without 
connectivity processes all future-dated events at the indicated date.
Character set encoding is used to parse data from IDocs.
The driver allows you to specify which character set encoding is used to parse data from IDocs. 
If nothing is specified, the driver uses the platform default encoding. If you specify a character 
set incorrectly, the driver initialization fails. You specify this encoding option in the driver 
configuration parameters.
Subscriber channel events are applied only to the current instance of SAP Infotype data. 
Future-dated instances are not affected.
The Subscriber Channel offers several modes for synchronizing Communication and Internal 
Data infotypes. All other updates are made as changes to the current valid data.
The JCOTEST utility validates connectivity.
A JCOTEST utility validates that all JCO connectivity and authentication parameters are 
configured correctly. 

1.4  Product Components
This section contains information about the following Identity Manager Driver for SAP HR 
components.

“Driver Configurations” on page 15
“Driver Shim” on page 15
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“Schema Map Generation Utility” on page 15
“SAP Java Connector Test Utility” on page 15

1.4.1  Driver Configurations
Driver configurations provide you with preconfigured policies to get you started with your 
implementation. The driver configuration for this driver is SAPHR-IDM3_5_0-V1.xml and can be 
imported through Novell iManager or Designer. 

1.4.2  Driver Shim
The driver shim handles communication between the SAP HR database and the Metadirectory 
engine. 

1.4.3  Schema Map Generation Utility
The driver comes packaged with various schema maps of the HRMD_A IDoc file. These maps are 
generated using a Win32 executable schema map generation utility program called metamap.exe.

This program generates a schema file using the SAP RFCSDK and then parses the default schema 
file into a schema map. The schema map file is named after the IDoc type specified and contains a 
.meta filename extension (for example, HRMD_A03.meta). This program is available in Win32 form 
only. Default maps of HRMD_A03.meta (SAP R/3 version 4.5B) and HRMD_A05.meta (SAP R/3 
version 4.6C) are provided with the product. Only SAP-defined IDocs can be mapped with the 
utility. Customized IDocs can be mapped manually if required.

1.4.4  SAP Java Connector Test Utility
Users implementing the driver must download the SAP JCO and install it. The SAP Java Connector 
(JCO) Test utility enables you to check for JCO installation and configuration issues prior to 
configuring the driver. You can use the JCO test utility to validate installation and connectivity to 
the SAP JCO client, as well as testing for accessibility to the HR BAPIs used by the driver. For more 
information, refer to Section 6.4, “Using the SAP Java Connector Test Utility,” on page 48.

1.5  Publishing to the Identity Vault
The SAP HR system is the authoritative source of HR data, and can propagate all Add, Delete, and 
Modify object event data to the Identity Vault. The Publisher channel is the component used for 
propagation.

For data to flow from the SAP HR system, the driver utilizes the SAP ALE technology to publish 
HR Master data records and captures incremental changes using change pointers. The HRMD_A 
message IDocs are transported using a File port that stores the IDocs on the SAP host system. The 
driver handles the parsing and filtering of the IDoc file, and provides secure transport of the data to 
the eDirectory. Only data elements specifically selected by the system administrator are transported 
from the host system to the Identity Vault.
Introducing the Identity Manager Driver for SAP HR 15
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1.5.1  IDoc Consumption by the Driver
The driver consumes only Output IDoc files with the client number that is reserved for the driver, 
thus ensuring the privacy of other IDocs that might be generated by another driver configuration. 
Only the IDoc attributes that have been specified in the driver Publisher filter are published to the 
Identity Vault. 

The format of a successfully published IDoc file is:

(O)utput>_<client number>_<consecutive IDoc number>

For example:

O_300_0000000000001001. 

After the specified attributes have been published, the filename of the IDoc file is modified to reflect 
the status of the publication processes. The driver caches the status of every event and associates the 
status with the object information in the IDoc. If multiple objects are processed from the IDoc, there 
might be multiple output files with different extensions created.

The following table lists the IDoc status and corresponding suffix:

You should determine what action is required, if any, after IDoc publication is complete. 

NOTE: Removing the filename extension makes the IDoc available for re-processing. 

If a policy generates multiple events from one object, the worst-case status is cached for the IDoc 
object. For example, if an IDoc contains data for Person object 00001234 and that data triggers 
policy events for the eDirectory User, his Job, and his Position, three separate <status> elements are 
returned. If two of the events have a success status, and the third status is warning, the warning 
status is used.

After all of the objects in the IDoc have been processed, the driver creates output files based on the 
status of events. If the IDoc contains warning status events, an IDoc file is generated containing all 
of the objects whose status was warning. The name is a concatenation of the original IDoc name and 
a W.warn extension (for example, O_001_0002 becomes O_001_0002W.warn.) In a similar fashion, 
if the original IDoc contains error or fatal status events, a file with an  F.fail extension is generated 
with those events in it.

To reprocess the IDoc, remove the extension. The use of the X character before the extension helps 
ensure that subsequent reprocessing events do not overwrite the status files from the previous 
processing attempts.

IDoc Status Filename Suffix

Processing, but not published .proc

Processing, but not published (future date IDoc) .futp

Processed successfully and published .done

Processed with an error or warning .F.fail or W.warn

Processed with corrupt or illegitimate data .bad

Process on date shown in timestamp <8 digit timestamp>.futr
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1.5.2  IDoc Object Types Consumed by the Driver
Object Types vary from system to system and can include objects such as Person, Job, or 
Organizational Unit. The driver allows the administrator to configure which object types can be 
processed by the driver. 

Only object types specified in the configuration and object types that are in the Publication Filter are 
processed. The driver parses the data for each object individually and transmits the data to the 
Metadirectory engine as a single transaction.

NOTE: If SAP connectivity is specified, the driver attempts to populate empty Publisher values by 
reading values from the SAP server. This only occurs if the Metadirectory engine requests more data 
(via a query request) when trying to complete an Add event operation. 

1.5.3  Attribute Mapping from the SAP HR Database to 
eDirectory
Schema mapping is used by Identity Manager to translate data elements as they flow between the 
SAP HR database and eDirectory. The SAP HR schema is based on the SAP HRMD_A message 
type. The schema map contains all attributes of the various data infotypes in the HRMD_A message 
types. 

Several of the HRMD_A infotypes could be instantiated multiple times on the HR personnel 
records. Infotypes such as P0006 (Private Address) and P0105 (Communication) might be used 
several times to indicate unique subtypes. The Private Address infotype might have, for example, 
Home, Work, or Temporary subtypes. The Communication infotype might contain Cell, Pager, 
EMail or other subtypes. The eDirectory system administrator can configure the driver to receive 
whatever subtypes of P0006 and P0105 infotypes are desired. The SAP HRMD_A messages that are 
generated by the SAP HR system are posted in the form of a text file. The schema map also contains 
the file position offset and length of each attribute in each segment of infotype data. 

This information is presented in a schema map. The map elements have the following format:

<Segment Infotype>:<Infotype Attribute>:<Infotype Subtype> or none: <Segment 
offset>:<Attribute length>

Below are a few examples of maps between SAP HRMD_A attributes and eDirectory attributes. The 
Infotype P0002 attributes have no possible subtypes. Infotypes P0006 and P0105 have a 
configurable set of subtypes.

eDirectory Attribute SAP HR Attribute

Given Name P0002:VORNA:none:134:25

Surname P0002:NACHN:none:84:25

City P0006:ORT01:US01:133:25

Home City P0006:ORT01:1:133:25

Internet EMail Address P0105:USRID:MAIL:78:30

Mobile P0105:USRID:CELL:78:30

Pager P0105:USRID:PAGR:78:30
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18 Identit

novdocx (en)  17 S
eptem

ber 2009
The driver only utilizes configuration for Private Address (0006) and Communication (0105) 
infotypes. Mapping of additional instance-specific infotype attributes might cause errors caused by a 
many-to-one object relationship.

1.6  Subscribing from the Identity Vault
The Subscriber channel of the driver is the component responsible for synchronizing data from the 
Identity Vault, including data that was obtained from other authoritative data sources, into the SAP 
HR database. Because the SAP HR system is always viewed as an authoritative source of personnel 
object creation and deletion, the Subscriber channel is configured to only allow data to be queried, 
or read, from the SAP HR system, and to allow modification of existing object records.

The Subscriber channel is capable of synchronizing fewer data elements to SAP than the Publisher 
channel can synchronize to eDirectory. For data to flow from the Identity Vault to the SAP HR 
system, the driver utilizes SAP-released BAPI functions to make changes to employee records. 
Because of BAPI restrictions, the driver completely supports only the following infotype data:

Personal Data (Infotype 0002)
Private Address (Infotype 0006)
Communication (Infotype 0105)
Internal Data (Infotype 0032)

The system administrator specifically selects which attributes from these infotypes can be modified. 

Home Phone P0006:TELNR:1:195:14

eDirectory Attribute SAP HR Attribute
y Manager Driver 3.5.1 for SAP HR Guide
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2Installing the Driver

As part of the driver installation and configuration, you should complete the following tasks: 

Section 2.1, “Understanding Driver Prerequisites,” on page 19
Section 2.2, “Planning for Installation,” on page 19
Section 2.3, “Overview: Basic Steps,” on page 20
Section 2.4, “Installing the SAP HR Driver,” on page 21
Section 2.5, “Installing Driver Configuration Import Files,” on page 23
Section 2.6, “Importing the Driver Configuration,” on page 24

These tasks are explained in detail in this section. After you finish installing the driver and 
importing the driver configuration file, proceed to Chapter 5, “Understanding ALE Technologies,” 
on page 37 to learn more about the SAP system configuration requirements.

2.1  Understanding Driver Prerequisites
The driver requires the following prerequisites. Ensure that you meet these criteria before you install 
the driver.

Novell® Identity Manager 3.5.1

The system where the driver shim is running must have the SAP Java* Connector (JCO) client 
technology installed for connectivity to the SAP HR system. 

This client is freely available to SAP customers and developer partners through SAP, and is 
provided for most popular server operating systems. You can download the JCO from the SAP 
Connectors site (http://service.sap.com/connectors).

SAP HR revision level 4.5B or higher.

The driver shim runs on any SAP R/3 host system. As part of the installation, you can install 
the Remote Loader service on the SAP system. For more information about using SSL to 
secure the communication between the Remote Loader and the Metadirectory engine, refer to 
Section 2.4, “Installing the SAP HR Driver,” on page 21.

2.2  Planning for Installation
Before you install and use the driver, you should determine which kind of installation you want to 
use: local or remote. 

When to Use a Local Installation

A local installation installs the driver on the same host computer where you have Identity Manager 
installed. 
Installing the Driver 19
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When to Use a Remote Installation

A remote installation installs the driver on a different computer than the one where Identity Manager 
is installed. Remote installations use SSL encryption to ensure data privacy. You should use this 
configuration when it is not possible or desirable to run Identity Manager on the SAP host system.

To know more about the Remote Loader and the shim that it uses, see “Deciding Whether to Use the 
Remote Loader” in the Novell Identity Manager 3.5.1 Administration Guide.

2.3  Overview: Basic Steps
The following figure illustrates options that you can select when installing Identity Manager.

Figure 2-1   Identity Manager Installation Options

Installing the SAP HR driver shim requires two basic steps:

Option Description

Metadirectory Server Installs Identity Manager and the Metadirectory engine

Connected System Installs the Remote Loader

Identity Manager Web 
Components

Installs the driver configuration file
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Typically, you install the SAP HR driver components when you install Identity Manager (or Remote 
Loader) and Web components. However, you can install them later.

2.4  Installing the SAP HR Driver
Section 2.4.1, “Installing the Shim on a Metadirectory Server,” on page 21
Section 2.4.2, “Installing the Shim on a Remote Loader,” on page 22

2.4.1  Installing the Shim on a Metadirectory Server
1 On the server where the Identity Vault and the Metadirectory engine are running, launch the 

Identity Manager installation. 
Run the installation program from the Identity Manager CD or the download image.

2 In the Welcome dialog box, click Next, then accept the license agreement.
3 In the first Identity Manager Overview dialog box, review information, then click Next.

The dialog box provides information on the following:
A Metadirectory Server
A Connected System Server

4 In the second Identity Manager Overview dialog box, review information, then click Next.
The dialog box provides information on the following:

A Web-based Administration Server
Utilities

5 In the Please Select the Components to Install dialog box, select Metadirectory Server, then 
click Next.

Step What to Select during Installation

1. Install the SAP HR driver shim on the 
Metadirectory engine server or the Remote 
Loader server.

2. Import the driver configuration file for the 
SAP HR driver through iManager. 

Select the Metadirectory Server or Identity 
Manager Connected System option. See 
Section 2.4, “Installing the SAP HR Driver,” on 
page 21.

Select the Identity Manager Web Components 
option. See Section 2.5, “Installing Driver 
Configuration Import Files,” on page 23.
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If iManager is already installed on this machine, and if you prefer to install the iManager plug-
ins and configuration files at this time, also select Identity Manager Web Components.

6 In the Select Drivers for Engine Install dialog box, select Metadirectory Engine and select SAP 
HR, then click Next.

7 In the Identity Manager Upgrade Warning dialog box, click OK.
8 In the Schema Extension dialog box, type a username and password, then click Next.
9 Review the selected options, then click Finish.

2.4.2  Installing the Shim on a Remote Loader
This option enables you to install the SAP HR driver shim to run on a server that is separate from the 
server running the Metadirectory engine.

1 On the server where the Remote Loader is running, launch the Identity Manager installation.
Run the installation program from the Identity Manager CD or the download image.

2 In the Welcome dialog box, click Next, then accept the license agreement.
3 In the first Identity Manager Overview dialog box, review information, then click Next.

The dialog box provides information on the following:
A Metadirectory Server
A Connected System Server

4 In the second Identity Manager Overview dialog box, review information, then click Next.
The dialog box provides information on the following:

A Web-based Administration Server
Utilities

5 In the Please Select the Components to Install dialog box, deselect Metadirectory Server and 
other options, select Identity Manager Connected System, then click Next.
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6 Specify the installation path, then click Next.
7 In the Select Drivers for Engine Install dialog box, select Remote Loader Service and SAP HR, 

then click Next.
8 In the Identity Manager Upgrade Warning dialog box, click OK.
9 Review the selected options, then click Finish.

2.5  Installing Driver Configuration Import Files
This option installs the plug-ins to Identity Manager and the driver configurations. After installing 
the files, you use iManager to import the SAP HR configuration file into a driver set and configure 
the driver.

You might have already installed these files, when you installed the Metadirectory engine or Remote 
Loader. To install the files separately:

1 On the server where iManager is installed, launch the Identity Manager installation.
2 In the Welcome dialog box, click Next, then accept the license agreement.
3 In the two Identity Manager Overview dialog boxes, review information, then click Next.
4 In the Please Select the Components to Install dialog box, deselect all options except Identity 

Manager Web Components, then click Next.
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5 Select Identity Manager Driver Configurations, then click Next.

You can install the driver configuration files when you install the Novell iManager plug-ins, or 
you can install the files separately.

6 Review the selected options, then click Finish.

2.6  Importing the Driver Configuration
The Create Driver Wizard helps you import the basic driver configuration file for SAP HR. This file 
creates and configures the objects and policies needed to make the driver work properly. The driver 
can be created and imported through Designer or iManager.

Section 2.6.1, “Importing the Driver Configuration File in Designer,” on page 25
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Section 2.6.2, “Importing the Driver Configuration File in iManager,” on page 25
Section 2.6.3, “Configuration Parameters,” on page 26

2.6.1  Importing the Driver Configuration File in Designer
There are many different ways of importing the driver configuration file. This procedure only 
documents one way.

1 Open a project in Designer. In the Modeler, right-click the driver set and select New > Driver.
2 From the drop-down list, select SAP HR, then click Run.
3 Configure the driver by filling in the fields. Specify information for your environment. For 

information on the settings, see Section 2.6.3, “Configuration Parameters,” on page 26 for 
more information.

4 After specifying parameters, click Finish to import the driver.
5 After the driver is imported, customize and test the driver.
6 After the driver is fully tested, deploy the driver into the Identity Vault. See “Deploying a 

Driver to an Identity Vault” in the Designer 2.1 for Identity Manager 3.5.1.

2.6.2  Importing the Driver Configuration File in iManager
The following instructions explain how to create the driver and import the driver’s configuration.

1 In Novell iManager, click Identity Manager Utilities > Import Configurations.
2 Select a driver set, then click Next.

If you place this driver in a new driver set, you must specify a driver set name, context, and 
associated server.

3 Select how you want the driver configurations sorted:
All configurations
Identity Manager 3.5 configurations
Identity Manager 3.0 configurations
Configurations not associated with an IDM version

4 Select SAP HR, then click Next.
5 Configure the driver by filling in the configuration parameters, then click Next. For information 

on the settings, see Section 2.6.3, “Configuration Parameters,” on page 26.
6 Define security equivalences using a user object that has the rights that the driver needs to have 

on the server, then click OK.
The tendency is to use the Admin user object for this task. However, you might want to create a 
DriversUser (for example) and assign security equivalence to that user. Whatever rights that the 
driver needs to have on the server, the DriversUser object must have the same security rights. 

7 Identify all objects that represent administrative roles and exclude them from replication, then 
click OK.
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Exclude the security-equivalence object (for example, DriversUser) that you specified in 
Step 6. If you delete the security-equivalence object, you have removed the rights from the 
driver, and the driver can’t make changes to Identity Manager.

8 Review the driver objects in the Summary screen, and then click Finish.

2.6.3  Configuration Parameters

Parameter Name Parameter Description

Driver name The actual name you want to use for the driver. 

Organizational Object 
Container

The name of the Organization Unit object under which published 
SAP Organizational (O) objects are placed. You can modify this via 
the driver’s Global Configuration Values (GCVs.)

Position Object Container The name of the Organizational Unit object under which published 
SAP Position (S) objects are placed. You can modify this via the 
driver’s Global Configuration Values (GCVs.)

Job Object Container The name of the Organizational Unit object under which published 
SAP Job (C) objects are placed. You can modify this via the driver’s 
Global Configuration Values (GCVs.)

Active Users Container The name of the Organizational Unit object where Active users are 
placed. You can modify this via the driver’s Global Configuration 
Values (GCVs.)

Inactive Users Container The name of the Organizational Unit object where Inactive users are 
placed. You can modify this via the driver’s Global Configuration 
Values (GCVs.)

Active Employees Group The name of the Group object to which Active Employee users are 
added. To learn more about determining Employee status, refer to 
“Using the Relationship Query” on page 48.

You can modify this via the driver’s Global Configuration Values 
(GCVs.)

Active Managers Group The name of the Group object to which Active Manager users are 
added. To learn more about determining Employee status, refer to 
“Using the Relationship Query” on page 48.

You can modify this via the driver’s Global Configuration Values 
(GCVs.)

SAP Client Number The client number to be used on the SAP application server. This is 
referred to as the Client in the SAP R/3 logon screen.

SAP Language Code The language this driver uses for the SAP session. This is referred 
to as the Language in the SAP R/3 logon screen.

Metadata File Directory The file system location in which the SAP Metadata definition file 
resides. By default, this is in the SAPUtils subdirectory of the 
driver’s installation directory. 

IMPORTANT: This must be on the same system where the driver 
shim runs.
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The additional driver parameters are set to default values during the import process, but they can be 
modified in iManager (by clicking the Driver Configuration tab on the driver object.)

IDoc File Directory The file system location in which the SAP HR IDoc files are placed 
by the SAP ALE system.

IMPORTANT: This must be accessible to the driver shim process.

Password Failure Notification 
User

Password synchronization policies are configured to send e-mail 
notifications to the associated user when password updates fail. You 
have the option of sending a copy of the notification e-mail to 
another user, such as a security administrator. If you want to send a 
copy, you can specify or browse for the DN of that user. Otherwise, 
leave this field black.

Publisher Channel Only Select whether you want the driver to use the Publisher channel only 
or if you want it to use both the Publisher and Subscriber channels.

Enable or Disable Publisher 
Connection to the SAP 
Application Server

Select Enable if you want the Publisher channel to read data from 
the SAP server in addition to IDoc data. 

Select Disable to use IDoc data only.

SAP Application Server The host name or IP address for connecting to the appropriate SAP 
application server. This is referred to as the Application Server in the 
SAP logon properties.

SAP System Number The SAP system number on the SAP application server. This is 
referred to as the System Number in the SAP logon properties.

SAP User ID The ID of the user this driver uses for the SAP system logon. This is 
referred to as the User in the SAP R/3 logon screen.

SAP User Password The User password this driver uses for the SAP system logon. This 
is referred to as the Password in the SAP R/3 logon screen.

Install Driver as Remote/
Local

Configure the driver for use with the Remote Loader service by 
selecting the Remote option, or select Local to configure the driver 
for local use. If Local is selected, you can skip the remaining 
parameters.

Remote Host Name and Port Specify the host Name or IP address and port number for where the 
Remote Loader service has been installed and is running for this 
driver. The default port is 8090. 

Driver Password The driver object password is used by the Remote Loader to 
authenticate itself to the Identity Manager server. It must be the 
same password that is specified as the driver object password on 
the Identity Manager Remote Loader.

Remote Password The Remote Loader password is used to control access to the 
Remote Loader instance. It must be the same password that is 
specified as the Remote Loader password on the Identity Manager 
Remote Loader. 

Parameter Name Parameter Description
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Parameter Name Parameter Description

Character Set 
Encoding

The character set encoding used to parse data from IDocs. If not specified, the 
driver uses the platform default encoding. If you incorrectly specify a character 
set, the driver initialization fails (default: blank)

Master HR IDoc The name of the IDoc type that is generated by the SAP ALE system to publish 
SAP HR database Master data modification. If not specified, the driver 
determines the revision of the SAP HR system and default to the standard IDoc 
type for that revision of SAP (default: HRMD_A05)

This field is optional, unless you select the Publisher channel Only option.

Object Type 
Code

A list parameter that allows an administrator to specify which HR object types are 
synchronized (default: P, S, O, and C.)

(Optional) 
Address 
Subtype Code

A list of configuration parameters that allows an administrator to specify which 
subtype of data the SAP Private Address infotype the driver synchronizes 
(default: 1 and US01)

(Optional) 
Communication 
Subtype Code

A list configuration parameter that allows an administrator to specify which 
subtype data of the SAP Communication infotype the driver synchronizes 
(default: CELL, MAIL, PAGR.) 

Poll Interval 
(seconds)

Specifies how often the driver polls for unprocessed IDocs (default: 5 seconds.)

Future-dated 
Event Handling 
Option

The processing of this option is determined by the Begin and End validity dates of 
the desired IDoc infotypes. There are four possible values for this parameter. The 
driver default is to Publish on Future Date.
 
Publish Immediately - Indicates that all attributes will be processed by the driver 
when the IDoc is available. A time stamp is set for each attribute that represents 
the validity period.

Publish on a Future Date - Indicates that only attributes that have a current or 
past time stamp will be processed by the driver when the IDoc is available. 
Future-dated infotype attributes are cached in a .futr file to be processed at a 
future date.

Publish Immediately and on Future Date - Indicates that the driver will blend 
options 1 and 2. All attributes will be processed, with a time stamp, at the time the 
IDoc is available. All future-dated infotype attributes are also cached in a.futr 
file to be processed at a future date.

Publish Immediately and Daily through Future Date - Indicates that the driver will 
process all events at the time the IDoc is made available. All future-dated infotype 
attributes are cached in a .futr file to be processed again on the next calendar 
day. This continues until the attributes are sent for a final time on the future date.

Future-dated 
Event Validity 
Checking 
Option

Specify whether or not the driver attempts to filter out stale data in future-dated 
IDocs (by verifying the begin and end validity dates of the data.)

Publish History 
Items

Specifies if data values that are no longer valid are published by the driver 
(default: Do Not Publish History Data.)
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Communication 
Change Mode

This Subscriber channel parameter specifies how the driver handles requests to 
change, remove, or add Communication (Infotype 0105) record instances on 
employees. There are three modes of operation available. For more information 
on the functionality of the various modes of operation, see Appendix D, 
“Subscriber Change Modes and Validity Date Modes,” on page 119.

Options include:
Delimit mode
Delete mode
Change mode (default driver mode)

Communication 
Validity Date 
Mode

This Subscriber channel parameter specifies how Beginning and Ending validity 
dates are set on newly created Communication record instances on employees. 
There are two modes of operation available. For more information on the 
functionality of the various modes of operation, see Appendix D, “Subscriber 
Change Modes and Validity Date Modes,” on page 119.

Internal Data 
Change Mode

This Subscriber channel parameter specifies how the driver handles requests to 
change, remove, or add Internal Control Data (Infotype 0032) record instances on 
employees. There are three modes of operation available. For more information 
on the functionality of the various modes of operation, see Appendix D, 
“Subscriber Change Modes and Validity Date Modes,” on page 119.

Options include:
Delimit mode
Delete mode
Change mode (default driver mode)

Internal Data 
Validity Date 
Mode

This Subscriber channel parameter specifies how Beginning and Ending validity 
dates are set on newly created Internal Control Data record instances on 
employees. There are two modes of operation available. For more information on 
the functionality of the various modes of operation, see Appendix D, “Subscriber 
Change Modes and Validity Date Modes,” on page 119.

Options include:
Default mode
Current Date Mode (default driver mode)

Parameter Name Parameter Description
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3Upgrading the Driver

If you have been using a previous version of the driver, follow these instructions instead of the ones 
in Chapter 2, “Installing the Driver,” on page 19.

Identity Manager 3.5 contains a new architecture for how policies reference one another. To take 
advantage of this new architecture, the driver configuration file provided for SAP must be upgraded. 
For more information on the new architecture, see “Upgrading Identity Manager Policies” in the 
Understanding Policies for Identity Manager 3.5.1. You can upgrade the driver in Designer or 
iManager.

If you are upgrading from Identity Manager 3.5.0 to Identity Manager 3.5.1, the following 
information does not apply.

Section 3.1, “Upgrading the Driver in Designer,” on page 31
Section 3.2, “Upgrading the Driver in iManager,” on page 34

3.1  Upgrading the Driver in Designer
1 Make sure you have updated your driver with all the patches for the version you are currently 

running.
We recommend this step for all drivers, to help minimize upgrade issues.

2 Back up the driver. See Chapter 11, “Backing Up the Driver,” on page 95 for instruction on 
how to back up the driver.

3 Install Designer version 2.0 or above, then launch Designer.
If you had a project open in Designer when you upgraded Designer, proceed to Step 4. If you 
didn’t have a project open in Designer when you upgraded Designer, skip to Step 5.

4 If you had a project open when upgrading Designer, the following warning message is 
displayed. Read the warning message, then click OK.

Designer closes the project to preform the upgrade.
5 In the Project view, double-click System Model to open and convert the project. 
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6 Read the Project Converter message explaining that the project is backed up, converted to the 
new format, changes logged to a file, and the new project is opened, then click Next. 

7 Specify the name of the backup project name, then click Next. 
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8 Read the project conversion summary, then click Convert. 

9 Read the project conversion result summary, then click Open Project. 
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If you want to view the log file that is generated, click View Log. 

3.2  Upgrading the Driver in iManager
1 Make sure you have updated your driver with all the patches for the version you are currently 

running.
We recommend this step for all drivers, to help minimize upgrade issues.

2 Back up the driver. See Chapter 11, “Backing Up the Driver,” on page 95 for instruction on 
how to back up the driver.

3 Verify that Identity Manager 3.5.1 has be installed and you have the current plug-ins installed, 
then launch iManager.

4 Click Identity Manager > Identity Manager Overview.
5 Click Search to find the Driver Set object, then click the driver you want to upgrade.
6 Read the message that is displayed, then click OK.
7 If there is more than one driver to upgrade, repeat Step 2 through Step 6.
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4Activating the Driver

Novell® Identity Manager, Integration Modules, and the Provisioning Module must be activated 
within 90 days of installation, or they shut down. At any time during the 90 days, or afterward, you 
can choose to activate Identity Manager products.

To activate the driver, see “Activating Novell Identity Manager Products” in the Identity Manager 
3.5.1 Installation Guide.
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5Understanding ALE Technologies

Section 5.1, “Application Link Enabling Technology,” on page 37
Section 5.2, “Clients and Logical Systems,” on page 37
Section 5.3, “Message Type,” on page 38
Section 5.4, “IDoc Type,” on page 38
Section 5.5, “Distribution Model,” on page 38
Section 5.6, “Partner Profiles,” on page 38
Section 5.7, “Port,” on page 38
Section 5.8, “Port Definition,” on page 39
Section 5.9, “File Port,” on page 39
Section 5.10, “Change Pointers,” on page 39
Section 5.11, “Change Document/IDoc Outbound Processing,” on page 39

5.1  Application Link Enabling Technology
Application Link Enabling (ALE) technology enables communication between SAP and external 
systems such as Novell® eDirectory™. ALE is comprised of various components. When 
configuring the SAP system to enable the driver, you should consider the following ALE 
components and their relationship to the driver:

Clients and Logical Systems
Message Types
IDoc Type
Distribution Model
Partner Profiles
Port Definition
File Port
Change Document/IDoc Outbound Processing 

Refer to Section 6.1, “Configuring the SAP System,” on page 41 for instructions on how to 
configure these SAP system parameters.

5.2  Clients and Logical Systems
In the SAP configuration for the driver, a logical system is a representation of either a SAP system 
or an external system. The logical system is used to distribute data to and from SAP. Every R/3 or 
SAP system needs to have a base logical system associated with a client. There is a one-to-one 
relationship between the client and the logical system. 

The driver uses an outbound ALE interface. In an outbound ALE interface, the base logical system 
becomes the sender for outbound messages and the receiver of inbound messages. A SAP user is 
likely logged into the base logical system/client when making changes to the database (for example, 
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hiring an employee, updating position data, terminating an employee, etc.) A logical system must 
also be defined for the receiving process. This logical system acts as the receiver of outbound 
messages.

5.3  Message Type
A message type represents the type of data that is exchanged between the two systems. For the 
driver, the HRMD_A message type is used. A message type characterizes data being sent across the 
systems and relates to the structure of the data, also known as an IDoc type (for example, 
HRMD_A05).

5.4  IDoc Type
Intermediate Document (IDoc) Type represents the structure of the data associated with a message 
type. ALE technology uses IDocs to exchange data between logical systems. An IDoc is an object 
with the data of a specific message type in it. IDocs consist of three record types:

1. The control record
2. The data record
3. The status record

The control record contains information about the IDoc, such as what IDoc type it is, the message 
type, the sending and receiving systems, direction, etc.

The data record contains the application data. Data records consist of several fields that describe the 
content of the specific object.

The status record contains data on the state of the processing of the IDoc.

5.5  Distribution Model
The distribution model is a tool that stores information about the flow of message types between 
systems. A distribution model must be configured when setting up the driver. After the two logical 
systems have been defined and you have a general understanding of message types and IDocs, you 
can configure your distribution model. 

The distribution model determines what message types can be sent from a client to another client, as 
well as the sending and receiving systems. Filters for IDoc segments can also be applied to 
distribution models.

5.6  Partner Profiles
Partner profiles specify the components used in an outbound process. Some of these components 
include the IDoc type, message type, IDoc size, mode, and the person to be notified in case of errors. 

5.7  Port
A port is the communication link between the two logical systems.
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5.8  Port Definition
A port definition is used in an outbound process to define how documents are transferred to the 
destination system.

5.9  File Port
A file port is used when IDocs are transferred to a file.

5.10  Change Pointers
Change pointers capture a master data change in SAP for a specific message type. These changes are 
saved into a change document. For example, when a new employee is hired, a change is made and 
captured in a change document.

5.11  Change Document/IDoc Outbound 
Processing
A SAP variant is defined for the HRMD_A0# message type. After the variant is defined, a job is 
scheduled for that variant, which captures the change documents and converts them into IDocs. The 
outbound process is then triggered.

NOTE: Multiple change documents can be captured within a single IDoc. The number of IDocs is 
determined by how frequently jobs are scheduled, not by the number of change documents created. 
For example, several records may be added, modified, or deleted within the specified job process 
period. All of these changes are included in a single IDoc.
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6Configuring the SAP System

You must configure the SAP system parameters to enable Application Link Enabling (ALE) 
processing of HRMD_A IDocs. This allows for data distribution between two application systems, 
also referred to as messaging. Novell® follows SAP’s general guidelines for configuring BAPI 
(Business Application and Programming Interface) and ALE technologies.

This section contains the following sections:

Section 6.1, “Configuring the SAP System,” on page 41
Section 6.2, “Using the Schema Metadata File,” on page 46
Section 6.3, “Using the Schema Map Generation Utility,” on page 48
Section 6.4, “Using the SAP Java Connector Test Utility,” on page 48

6.1  Configuring the SAP System
As part of configuring the SAP system, you should complete the following steps in this order:

1. “Defining Sending and Receiving Systems” on page 41
2. “Creating a Distribution Model” on page 42
3. “Creating a Port Definition” on page 43
4. “Generating Partner Profiles” on page 43
5. “Generating an IDoc” on page 44
6. “Activating Change Pointers” on page 45
7. “Scheduling a Job for Change Pointer Processing” on page 45
8. “Scheduling a Job” on page 45
9. “Testing the Change Pointer Configuration” on page 46

10. “Creating a CPIC User” on page 46

NOTE: The following instructions are for SAP version 4.6C. If you are using a previous version of 
SAP, the configuration process is the same; however, the SAP interface is different. 

6.1.1  Defining Sending and Receiving Systems
The sending and receiving systems must be defined for messaging. In order to distribute data 
between systems, you must first define both the sending and receiving systems as unique logical 
systems.

You must assign a client to the sending logical system. Since the receiving logical system is an 
external system, there is no need to assign it to a client. You should never assign the same client to 
more than one logical system. 
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For this particular solution, we recommend defining two logical systems. One logical system acts as 
the receiver and the other logical system acts as the sender. Although only one of these logical 
systems is used as a data source process (that is, the client/logical system where employee data is 
stored and “actions” occur), the second logical system is needed to represent the receiving process 
(in this case, the driver.) 

NOTE: Depending on your current SAP environment, you might not need to create a logical 
system. You might only need to modify an existing distribution model by adding the HRMD_A 
message type to a previously configured model view. For more information, see “Creating a 
Distribution Model” on page 42. 

It is important, however, that you follow SAP’s recommendations for logical systems and 
configuring your ALE network. The following instructions assume that you are creating new logical 
systems and a new model view.

Creating a Logical System

1 In SAP, type transaction code BD54.
2 Click New Entries.
3 Type an easily identifiable name to represent the SAP sender system. SAP recommends the 

following format for logical systems representing R/3 clients: systemIDCLNTclient number 
(such as ADMCLNT100).

4 Type a description for the logical system (such as Central System for SAP HR Distribution).
5 Add a second logical system name to represent the Identity Manager external receiver system 

(such as DRVCLNT100).
6 Type a description for the logical system (such as IDM HR Integration).
7 Save your entry.

Assigning a Client to the Logical System

1 In SAP, type transaction code SCC4.
2 Click Table View > Display > Change to switch from display to change mode.
3 Select the client from which you want User information distributed (such as 100).
4 Click Goto > Details > Client Details.
5 In the Logical System field, browse to the sender logical system you want to assign to this 

client (such as ADMCLNT100).
6 Save your entry.

6.1.2  Creating a Distribution Model
The distribution model contains essential information about message flow. The model view defines 
the systems that will communicate with each other and the messages that will flow between them. 
The distribution model forms the basis of distribution and controls it directly. 

To create a distribution model:

1 Verify that you are logged on to the sending system/client.
y Manager Driver 3.5.1 for SAP HR Guide



novdocx (en)  17 S
eptem

ber 2009
2 In SAP, type transaction code BD64. Ensure that you are in Change mode (click Table View > 
Display > Change.)

3 Click Edit > Model View > Create.
4 Type the short text to describe the distribution model (such as Client 100 Distribution to IDM). 
5 Type the technical name for the model (such as SAP2IDM).
6 Accept the default Start and End dates or specify valid values. Click the check mark icon to 

save your entry.
7 Select the view you created, then click Add Message Type.
8 Define the sender/logical system name.
9 Define the receiver/server name.

10 Define the Message Type you want to use (HRMD_A), then click Continue.
11 Click Save.

6.1.3  Creating a Port Definition
The port is the communication channel to which IDocs are sent. The port describes the technical link 
between the sending and receiving systems. You should configure a file port for this solution. The 
file port is used to determine the directory and the file location to which IDocs are sent. 

To create a file port definition:

1 Type transaction code WE21.
2 Select File, then click the Create icon. Specify information for the following fields:

Name port
Port description
Version: Select SAP release 4.X

3 On newer SAP servers, it is possible that the database is Unicode. If this is true, select the 
Unicode Format checkbox on the System Setting tab.

4 Define the outbound file:
4a Select the physical directory. This is the directory where you want IDocs placed. You 

might need to create this directory.
Enter the directory where the outbound files are written, for example: 
\\SAPDEV\NOV\SYS\GLOBAL\SAPNDSCONNECTOR.

4b Enter the function module. This names the IDoc file in a specific format. Always use the 
following format: EDI_PATH_CREATE_CLIENT_DOCNUM.

5 Save your changes.

NOTE: You do not need to configure the other three tabs for the port properties 
(outbound:trigger, inbound file, and status file).

6.1.4  Generating Partner Profiles
The system automatically generates a partner profile or you can manually maintain the profile.
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NOTE: If you are using an existing distribution model and partner profile, you do not need to 
automatically generate a partner profile. Instead, you can modify it to include the HRMD_A 
message type.

To automatically generate a partner profile:

1 Type transaction code BD82.
2 Select the model view. This should be the model view previously created in “Creating a 

Distribution Model” on page 42.
3 Ensure the Transfer IDoc immediately and Trigger Immediately option buttons are selected.
4 Select a reasonable packet size value to ensure that IDoc files are not too large to process. We 

recommend a value of 100.
5 Click Execute.

Modifying Port Definition

When you generated a partner profile, the port definition might have been entered incorrectly. For 
your system to work properly, you need to modify the port definition. 

1 Type transaction code WE20.
2 Select Partner Type LS.
3 Select your receiving partner profile.
4 Select Outbound Parameters, then click Display.
5 Select message type HRMD_A.
6 Click Outbound Options, then modify the receiver port so it is the file port name you created in 

“Creating a Port Definition” on page 43.
7 From the Output Mode, select Transfer IDoc Immediately to send IDocs immediately after they 

are created.
8 From the IDoc Type section, select the latest version available for your system.
9 Click Continue/Save.

6.1.5  Generating an IDoc
1 Type transaction code PFAL.
2 Insert the Object Type P for person objects.
3 Enter an Employee’s ID for the Object ID or select a range of employees.

Under the Parallel Processing tab, set Number of Objects per Process to 100 if you select a 
range of employees.

4 Click Execute.
Ensure that the status is set to Passed to Port Okay.
The IDoc has been created. Go to the directory where IDocs are stored (it was defined in the 
file port setup) and verify that the IDoc text file was created. 
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6.1.6  Activating Change Pointers
To activate change pointers globally:

1 Type transaction code BD61.
2 Enable the Change Pointers Active tab.

To activate change pointers for a message type:

1 Type transaction code BD50.
2 Scroll to the HRMD_A message type.
3 Select the HRMD_A check box, then click Save.

6.1.7  Scheduling a Job for Change Pointer Processing
1 Type transaction code SE38 to begin defining the variant.
2 Select the RBDMIDOC program, select Variant, then click the Create icon.
3 Name the variant and give it a description. 

NOTE: Make note of the variant name so you can use it when scheduling the job.

4 Select the HRMD_A message type, then click Save.
You will be prompted to select variant attributes. Select the background processing attribute.

5 Click Save.

6.1.8  Scheduling a Job
1 Type transaction code SM36.
2 Name the job.
3 Assign Job Class.

Job Class is the priority in which jobs are processed. Class A is the highest priority and will be 
processed first. For a production environment, we recommend assigning the class to B or C.

4 Schedule a start time. Click the Start Condition tab, then click Date and Time. Specify a 
scheduled start time, which must be a future event.
4a Mark the job as a periodic job > click the Periodic Values tab, schedule how frequently 

you want the job to run, then press Enter. For testing purposes, we recommend setting this 
period to 5 minutes.

4b Click Save.
5 Define the job steps.

5a Type the ABAP program name: RBDMIDOC.
5b Select the variant you created in the previous step.

6 Click Save.

IMPORTANT: Click Save once; otherwise, the job will be scheduled to run multiple times.
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6.1.9  Testing the Change Pointer Configuration
1 From the SAP client, hire an employee.
2 Ensure that an IDoc was created. 

You can verify IDoc creation in two locations:
Type transaction code WE02
Go to the IDoc file locations

6.1.10  Creating a CPIC User
Users are client-dependent. For each client that will be using the driver, a system user with CPIC 
access must be created. 

1 From User Maintenance in SAP, specify a username in the user dialog box, then click the 
Create icon.

2 Click the Address tab, then specify data in the Last Name and Format fields.
3 Click the Logon Data tab, then define the initial password and set the user type to CPIC.
4 Click the Profiles tab, then add the SAP_ALL, SAP_NEW and S_A.CPIC profiles.
5 Click Save.

Initially, you can create a dialog user to test your SAP system configuration. If there are processing 
problems, you can analyze the dialog user in the debugger. You should also log into the SAP system 
once to set this user’s password. After the system is tested and works properly, you should switch to 
a CPIC user for security measures.

IMPORTANT: If restricted rights are assigned to the CPIC User, the Identity Manager and SAP 
administrators are responsible to ensure that sufficient rights are assigned to enable the configured 
level of integration. Appendix C, “Driver BAPIs,” on page 115 contains a table describing which 
BAPIs the driver uses.

6.2  Using the Schema Metadata File
The driver includes to default Metadata files: HRMD_A03.meta and HRMD_A05.meta. These files 
contain the SAP metaschema definitions of the HRMD_A03 IDoc type, which is the standard HR 
Master Data IDoc for version 4.5B of SAP R/3; and the HRMD_A05 IDoc type, which is the 
standard HR Master Data IDoc for version 4.6C.

These files are provided to two distinct purposes:

1. The driver uses a metadata file to generate an Application Schema Map when requested via the  
Refresh Application Schema option in iManager.

2. If a Character Set Encoding value is specified in the configuration, the driver opens the 
metadata file to determine if the encoding value specified is valid.
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A schema map must exist for the IDoc type that the driver consumes, whether that type is specified 
in the Master HR IDoc configuration parameter or if the driver selects a default type based on the 
version of the SAP Application server. Because only two maps are provided with the driver, you 
might need to create a new map for the IDoc type needed by the driver. There are two options for 
doing this:

You can simply copy the HRMD_A05.meta file to a new file, such as HRMD_A06.meta. This is 
acceptable as long as you do not need to publish newer infotypes not found in the HRMD_A05 
version. It is unlikely that newer infotypes will be needed.
You can execute the metamap.exe Schema Map Generation Utility. See Section 6.3, “Using 
the Schema Map Generation Utility,” on page 48 for more information.

6.2.1  Schema Metadata File Reduction
The size of the metaschema definitions can create problems for your driver configuration. The 
schema refresh can take a long time to process, especially because a copy of the map is generated for 
each object type you choose to synchronize. Additionally, the size of the schema in the driver 
configuration can be extremely large and cumbersome to navigate. For these reasons, it is acceptable 
to reduce the number of infotypes in the metadata files. 

You can edit the appropriate metadata file and remove all infotypes that are not used for your 
implementation. Simply search for the infotypes to remove (for examples, Infotype 0008 values can 
be found by searching for P0008) and deleting the SEGMENT: line and subsequent infotype field 
lines from the file. You should modify a copy of the original file. For most integrations, only 20-30 
percent of the infotypes are actually used.

IMPORTANT: You must be careful that you do not remove infotypes that are useful for policies or 
other object types being synchronized. Two infotypes of this nature are Infotype 1000 (for 
Descriptions of non-person objects) and Infotype 1001 (Relationships between objects.) These are 
both used in the default driver configuration.

You should also not remove fields from infotypes that are used in your integration. Field removal is 
extremely hard to detect if a mistake is made or if you want to return to an earlier version.

6.2.2  Schema Metadata File Extension
There are many situations where an IDoc is extended with custom infotypes or infotype fields. 
Because the schema map is based on standard SAP IDoc types, you must manually create these 
types of metadata extensions. There are several areas of concern:

If the infotype is an extension to the IDoc (for example, Infotype Z0001), you must ensure that 
the infotype header fields are present in a standard format. These standard fields start with the 
field PERNR and extend through field RESE2 in data infotypes. If these fields are not present 
or contain no data, many of the driver features such as future-dating and history-dating do not 
work.
The format of new infotypes is similar to the standard infotypes. The first field should be <5 
character infotype>:PERNR:0:8. When parsing an actual IDoc, the physical offset for the 
PERNR field is 63 (when starting from position 0.)
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You might also create schema extensions directly to the Mapping Rule without the need to update 
the metadata file. If you choose this option, which is often easier, remember the physical offset 
mentioned above when determining where your data fields of interest begin. The format for a direct 
mapping is described in Section 1.5.3, “Attribute Mapping from the SAP HR Database to 
eDirectory,” on page 17. Selecting field names is up to you, because the driver does not use them for 
processing, but they should be limited to 5 characters for consistency.

6.3  Using the Schema Map Generation Utility
The driver comes packaged with various schema maps of the HRMD_A IDoc file. These maps are 
generated using a Win32 executable schema map generation utility program called metamap.exe. 

The schema map generation utility is installed in the SAPUTILS folder in the remote loader or the 
Novell eDirectory™ directory. It contains the following files:

Metamap.exe

SAPRFC.INI

HRMD_A03.meta and HRMD_A05.meta
Logon.txt

Readme.txt

This program generates a schema file using the SAP RFCSDK and then parses the default schema 
file into a schema map. The schema map file is named after the IDoc type specified and contains a 
.meta filename extension (for example, HRMD_A03.meta). This program is available in Win32 form 
only. Only IDocs defined by SAP can be mapped with this utility. Custom IDocs can only be 
mapped manually using the base .meta file.

6.3.1  Editing SAPRFC.INI and LOGON.TXT
Follow the directions in the readme.txt file to configure these files for use on your SAP system.

6.4  Using the SAP Java Connector Test Utility
The driver uses the SAP Java Connector (JCO) and Business Application Programming Interface 
(BAPI) technologies to connect to and integrate data with eDirectory. The SAP JCO is a SAP client 
that creates service connections to a SAP R/3 system. After the driver is connected to the R/3 
system, it calls methods on business objects within the R/3 system via BAPI. 

This utility enables you to check for JCO installation and configuration issues prior to configuring 
the driver. Use the JCO test utility to validate installation and connectivity to the SAP JCO client, as 
well as testing for accessibility to the HR BAPIs used by the driver. 

In order to configure the driver, you must first download the SAP JCO and install it. For installation 
instructions, refer to the documentation accompanying the SAP JCO. 

There might be minor modifications to JCO components as the connector is updated by SAP. 
Always refer to the SAP installation documentation for proper configuration instructions.
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6.4.1  What Does the Utility Do?
The SAP JCO Test utility completes the following checks:

Ensures that the jco.jar file, which contains the exported JCO interface, is present.
Ensures that the JCO native support libraries are properly installed.
Ensures that connection parameters to the SAP R/3 target system are correct.
Ensures that the authentication parameters to the SAP R/3 target system are correct.
Ensures that the selected language code is valid.
Ensures that the BAPIs used by the driver are present as expected for the version of the SAP R/
3 target system.

6.4.2  Utility Prerequisites
Before you run the JCO Test utility, you must install the SAP JCO client for the desired platform. 
The JCO can only be obtained from the SAP Service Marketplace Web site (http://www.sap-ag.de/
services). The download is free to any SAP software customer or development partner, but you are 
required to log in. 

Follow the installation instructions for your platform. Each installation requires you to set one or 
two environment variables, such as CLASSPATH for the jco.jar file location. For the UNIX* 
platforms, set either the LD_LIBRARY_PATH or LIBPATH variables for the location of native 
support libraries. Ensure that these variables are set in the shell environment to run this test and for 
the subsequent use of the Identity Manager Driver for SAP HR. 

You must also make sure that you have your PATH environment variable set to include the path to 
your Java executable file. For Win32 platforms, the environment variables are set via the System 
configuration in the Control Panel. On UNIX systems, edit the appropriate .profile or .bash_profile 
to include and export these path variables.

6.4.3  Components
The JCO Test utility includes a JCOTest.class file. You need to create a batch or script file to run 
the test. The format of the batch or script file varies, depending on the platform on which the JCO 
client has been installed. 

The basic content of the file includes a path to the Java executable (or just java if your PATH is 
appropriately configured), and the name of the JCOTest.class file. A sample UNIX script file and 
Win32 batch file are listed below, where jco.jar is in the executable directory of the JCOTest.class 
file and the batch file:

Win32 jcotest.bat file
java -classpath %CLASSPATH%;. JCOTest

Unix jcotest file
java JCOTest

You must use proper slash notation when specifying pathnames and use the proper classpath 
delimiter for the platform. You must also remember that the name of the jco.jar or sapjco.jar 
file is case-sensitive on UNIX platforms and that the name of the test class, JCOTest, must be 
specified with proper case for any platform.
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6.4.4  Running and Evaluating the Test

Running the Test

To run the JCO Test utility on a Win32 platform:

1 From Windows Explorer, double-click your.bat file. 
or
From a command prompt, run your .bat script.

To run the JCO Test utility on a UNIX platform:

1 From your preferred shell, run your jcotest script file.

NOTE: When you run the test program, an error message might appear before any test output is 
displayed. This indicates an improper installation of the JCO client components. The error messages 
are documented for each platform in “Understanding Test Error Messages” on page 51.

Evaluating the Test

If the JCO client is installed properly, the following output is displayed:

**The SAP JCO client installation has been verified to be correct.

Version of the JCO-library: version information

Input SAP Server Connection Information
----------------------------------------

You then receive a series of prompts for connection and authentication information. All data must be 
provided unless a default value, identified by [] delimiters, is provided. Failure to fill in a response 
value to each prompt ends the test. Enter information for the following fields when prompted:

Application server name or IP address
System number[00]
Client number
User
User Password
Language code [EN]

The values you provide are the same values that could be used to authenticate via the SAPGUI 
client. Based on the validity of the input, the test either displays error messages with solution 
suggestions or runs to completion. At the end of the test, a status message displays. If the test 
indicates full functionality as required by the driver, the following status message appears (it 
describes valid values that can be used as the configuration parameters for the driver:

**All expected platform support is verified correct.
y Manager Driver 3.5.1 for SAP HR Guide



novdocx (en)  17 S
eptem

ber 2009
JCO Test Summary
----------------
Full JCO/BAPI Functionality has been verified.
The following parameters may be used for SAP HR Driver Configuration

Authentication ID: Username
Authentication Context: SAP Host Name/IP Address
Application Password: User password
Publisher Channel Only? 1
SAP System Number: System Number
SAP User Client Number: Client Number
SAP User Language: Language Code
Master HR IDoc: Default IDoc type for SAP R/3 version

If the test indicates that the functionality required by the driver is not available, the following status 
message is displayed:

**There are <number> required BAPI functions NOT supported on this platform.

JCO Test Summary
----------------
JCO/BAPI functionality issues have been detected that will prevent proper SAP 
HR Driver functionality.

Post-Test Procedures

After the JCO Test Utility has passed all tests successfully, the driver can be configured to run. 
Make sure that the jco.jar file is copied to the location where the sapshim.jar file has been 
installed.

On UNIX systems, ensure that the environment variables used for the successful completion of the 
JCO Test are also in the environment of the driver. If these conditions are met, there should be no 
driver errors that are related to the JCO.

6.4.5  Understanding Test Error Messages
Use the information in this section to analyze error messages that might display during the JCO 
Test. Some errors are applicable to all platforms, and other errors are platform-specific. 

The test has been run on the platforms listed below. Other UNIX platforms supported by JCO are 
configured in a similar manner and errors generated by improper JCO installation and configuration 
should be similar to the errors described for IBM*-AIX* and Solaris*.

“General Errors” on page 52
“Errors on Win32 Systems” on page 52
“Errors on IBM-AIX Systems” on page 53
“Errors on Solaris Systems” on page 53
“Errors on Linux Systems” on page 54
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General Errors

Errors on Win32 Systems

Error Message Problem

Error connecting to SAP host: 
com.sap.mw.jco.JCO$Exception: (102)

RFC_ERROR_COMMUNICATION: Connect to SAP 
gateway failed

Check values of Application Server Name/IP Address 
and System Number

This indicates that one or both of the values 
entered for Application Server Name or IP 
address and System Number are incorrect. 

Verify that these values are consistent with the 
information found in the Properties page of the 
SAP Logon dialog box used to connect to the 
SAP R/3 system.

Error authenticating to SAP host: 
com.sap.mw.jco.JCO$Exception: (103)

RFC_ERROR_LOGON_FAILURE: You are not 
authorized to logon to the target system (error code 1).

The authentication credentials are not valid. 
Verify that the values for Client Number, User, 
and User Password are correct.

Error connecting to SAP host: 
com.sap.mw.jco.JCO$Exception: (101) 
RFC_ERROR_PROGRAM: Language ’<value>’ not 
availableCheck value of Language Code

The language code selected is not valid or is not 
installed on the SAP R/3 system.

Error Message Problem

“jcotest' is not recognized as an internal or external 
command, operable program, or batch file.

The jcotest.bat batch file is not present.

Exception in thread “main” 
java.lang.NoClassDefFoundError: com/sap/mw/jco/
JCO$AbapExceptionor Exception in thread “main” 
java.lang.NoClassDefFoundError: com/sap/mw/jco/
JCO$Exception

The sapjco.jar file is not in the location 
specified in the jcotest.bat batch file.

Exception while initializing JCO 
client.java.lang.UnsatisfiedLinkError: no jRFC12 in 
java.library.path

Verify proper installation of JCO Native support libraries 
packaged with JCO client.

The jRFC12.dll file that shipped with the 
JCO client is not installed or is installed in an 
improper location. The default location for 
jRFC12.dll and libRfc32.dll is /
WINNT/system32.

Exception while initializing JCO 
client.java.lang.UnsatisfiedLinkError: 
C:\WINNT\system32\jrfc12.dll: Can’t find dependent 
libraries. 

Verify proper installation of JCO Native support libraries 
packaged with JCO client.

The librfc32.dll file shipped with the JCO 
client is not installed or installed in an improper 
location. The default location for jRFC12.dll 
and libRfc32.dll is /WINNT/system32.
y Manager Driver 3.5.1 for SAP HR Guide



novdocx (en)  17 S
eptem

ber 2009
Errors on IBM-AIX Systems

Errors on Solaris Systems

Error Message Problem

ksh: jcotest: not found. The jcotest script file is not present in the 
directory.

Exception in thread “main” 
java.lang.NoClassDefFoundError: com/sap/mw/jco/
JCO$AbapExceptionorException in thread “main” 
java.lang.NoClassDefFoundError: com/sap/mw/jco/
JCO$Exception

The sapjco.jar file is not in the location 
specified in the jcotest script file or the case 
specified for sapjco.jar does not match the 
actual file name.

Exception while initializing JCO 
client.java.lang.UnsatisfiedLinkError: no jRFC12 
(libjRFC12.a or .so) in java.library.path. 

Verify proper installation of JCO Native support libraries 
packaged with JCO client.

The libjRFC12.so file that shipped with the 
JCO client is not installed or is installed in an 
improper location. You must configure a 
LIBPATH environment variable to specify the 
location in which the file resides.

Exception while initializing JCO 
client.java.lang.UnsatisfiedLinkError: <path>/
libjRFC12.so: A file or directory in the path name does 
not exist.

Verify proper installation of JCO Native support libraries 
packaged with JCO client.

The librfccm.so file shipped with the JCO 
client is not installed or is installed in an 
improper location. You must copy the file to the 
same location as libjRFC12.so or configure 
the LIBPATH environment variable to specify 
the location in which the file resides.

Error Message Problem

ksh: jcotest: not found.orbash: jcotest: command not 
found

The jcotest script file is not present in the 
directory.

Exception in thread “main” 
java.lang.NoClassDefFoundError: com/sap/mw/jco/
JCO$AbapExceptionorException in thread “main” 
java.lang.NoClassDefFoundError: com/sap/mw/jco/
JCO$Exception

The jsapjco.jar file is not in the location 
specified in the jcotest script file or the case 
specified for sapjco.jar does not match the 
actual file name.

Exception while initializing JCO 
client.java.lang.UnsatisfiedLinkError: no jRFC12 in 
java.library.path

Verify proper installation of JCO Native support libraries 
packaged with JCO client.

The libjRFC12.so shipped with the JCO 
client is not installed or is installed in an 
improper location. You must configure a 
LD_LIBRARY_PATH environment variable to 
specify the location in which the file resides.

Exception while initializing JCO 
client.java.lang.UnsatisfiedLinkError: <path>/
libjRFC12.so: ld.so.1: <search-path>: fatal: librfccm.so: 
open failed: No such file or directory

Verify proper installation of JCO Native support libraries 
packaged with JCO client.

The librfccm.so file shipped with the JCO 
client is not installed or installed in an improper 
location. You must copy the file to the same 
location as libjRFC12.so or configure the 
LD_LIBRARY_PATH environment variable to 
specify the location in which the file resides.
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Errors on Linux Systems

Error Message Problem

ksh: jcotest: not found.orbash: jcotest: command not 
found

The jcotest script file is not present in the 
directory.

Exception in thread “main” 
java.lang.NoClassDefFoundError: com/sap/mw/jco/
JCO$AbapExceptionorException in thread “main” 
java.lang.NoClassDefFoundError: com/sap/mw/jco/
JCO$Exception

The sapjco.jar file is not in the location 
specified in the jcotest script file or the case 
specified for sapjco.jar does not match the 
actual file name.

Exception while initializing JCO 
client.java.lang.ExceptionInInitializerError: 
JCO.classInitialize(): Could not load middleware layer 
’com.sap.mw.jco.rfc.MiddlewareRFCno jRFC12 in 
java.library.path. 

Verify proper installation of JCO Native support libraries 
packaged with JCO client.

The libjRFC12.so file shipped with the JCO 
client is not installed or is installed in an 
improper location. You must configure a 
LD_LIBRARY_PATH environment variable to 
specify the location in which the file resides

Exception while initializing JCO 
client.java.lang.ExceptionInInitializerError: 
JCO.classInitialize(): Could not load middleware layer 
’com.sap.mw.jco.rfc.MiddlewareRFC<path>/
libjRFC12.so: librfccm.so: cannot open shared object 
file: No such file or directory.

Verify proper installation of JCO Native support libraries 
packaged with JCO client.

The librfccm.so file shipped with the JCO 
client is not installed or is installed in an 
improper location. You must copy the file to the 
same location as libjRFC12.so or configure 
the LD_LIBRARY_PATH environment variable 
to specify the location in which the file resides.
y Manager Driver 3.5.1 for SAP HR Guide
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7Understanding the Default Driver 
Configuration

This section explains how the default driver configuration uses policies and filters. You can use this 
overview as a basis to create your own policies and filters for specific business implementations. 

7.1  Using Policies
Policies are highly configurable for use within any business environment. Although each business is 
different, the default driver configuration is built with a scenario that involves synchronizing SAP 
Person (P), Organization (O), Position (S), and Job (C) objects into the Identity Vault.

7.1.1  Modifying Policies and the Filter
You must modify policies and filters to work with your specific business environment. We 
recommend that you make modifications in this order:

Modify the driver filter to include desired attributes to be synchronized.
Modify the Mapping policy to include all attributes specified in the driver filter.
Modify the InputTransformation policy
Modify the OutputTransformation policy
Modify the Publisher Placement policy
Modify the Publisher Matching policy
Modify the Publisher Creation policy
Modify the Publisher Command Transformation policy
Modify the Subscriber Matching policy

The Driver Filter

The driver filter contains the set of classes and attributes whose updates publish from the SAP 
system to the Identity Vault, and from the Identity Vault to SAP. 

NOTE: To use the default driver configuration, you shouldn’t filter out any of the CommExec, 
Organizational Role, or Organizational Unit attributes. Also, do not remove the Given Name, 
Surname, and workforceID attributes from the User class object.

The following table includes some examples of classes and attributes found in the driver filter:

Classes Attributes

CommExec Description
Understanding the Default Driver Configuration 55



56 Identit

novdocx (en)  17 S
eptem

ber 2009
The Schema Mapping Policy

The Schema Mapping policy is referenced by the driver object and applies to both the Subscriber 
and Publisher channel. The purpose of the Schema Mapping policy is to map schema names 
(particularly attribute names and class names) between the eDirectoryTM and the SAP HR database. 
Any modification or removal of existing entries in the Schema Mapping policy could destroy the 
default configuration and policies processing behavior. Adding new attribute mappings is optional. 
The following attribute mappings are included with the default driver configuration:

Organizational Role Description

directReports

manager

Role Occupant

Organizational Unit Description

User employeeStatus

Full Name

Given Name

homePhone

Initials

isManager

Login Disabled

manager

managerWorkforceID

mobile

OU

pager

Physical Delivery Office Name

Postal Code

S

SA

Surname

Telephone Number

Title

workforceID

Classes Attributes
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The User class is configured to synchronize bidirectionally between SAP and eDirectory. A change 
made in one system will transfer to the other system. However, changes made to the CommExec, 
Organizational Role, and Organizational Unit attributes are synchronized from SAP to eDirectory 
only.

All attributes in the Publisher and Subscriber filters should be mapped unless they are only used for 
policies processing (for example, Login Disabled.)

The following table includes common attribute mappings for the User class and their descriptions:

eDirectory Class SAP Class SAP Description

CommExec C Job

Organizational Role S Position

Organizational Unit O Organization

User P Person

eDirectory Attribute SAP Attribute Description SAP Attribute

Given name First Name P0002:VORNA:none:134:25

Initials Initials P0002:INITS:none:74:10

Internet EMail Address Communication ID/Number (with a 
mail subtype)

P0105:USRID:MAIL:78:30

NSCP:employeeNumber Personnel Number P0001:PERNR:none:0:8

OU Organizational Unit P0001:ORGEH:none:125:8

Postal Code Postal Code (work address subtype) P0006:PSTLZ:US01:183:10

S Region (State, Province, or County for 
the work address subtype) 

P0006:STATE:US01:248:3

Surname Last Name P0002:NACHN:none:84:25

employeeStatus Country ISO Code (work subtype) P0000:STAT2:none:79:1

homeCity City (permanent address subtype) P0006:ORTO1:1:133:25

homeFax Communication Type (permanent 
address subtype)

P0006:COM01:1:274:20

homePhone Telephone Number (permanent 
address subtype)

P0006:TELNR:1:195:14

Title Position P0001:PLANS:none:133:8

mobile Communication ID/Number (cell phone 
subtype)

P0105:USRID:CELL:78:30

pager Communication ID/Number (pager 
subtype)

P0105:USRID:PAGR:78:30

jobCode Job P0001:STELL:none:141:8
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The Input Transformation Policy

You modify the Input Transformation policy to implement your specific business rules. The Input 
Transformation policy is applied to transform the data received from the driver shim. 

The policy is applied as the first step of processing an XML document received from the driver 
shim. The Input Transformation policy converts the syntax of the SAP attributes into the syntax for 
eDirectory. The Input Transformation policy is implemented as an XSLT style sheet.

The default driver configuration includes templates that complete the following actions:

Modifies the association for non-Person objects to include Class code.
Manipulates the OU attribute to contain a name-number syntax.
Manipulates the Title to contain text data.
Manipulates the Job Code to contain text data.
Transforms Postal Address from string syntax to structure syntax.
Translates telephone numbers from a numerical string into a formatted telephone number.
Translates employee status from numerical format into either an A (Active) or I (Inactive) 
status code.
Adds an employee status code if not present in query replies.

The Output Transformation Policy

You modify the Output Transformation policy to implement your specific business rules. The 
Output Transformation policy is referenced by the driver object and applies to both the Subscriber 
channel and to the Publisher channel. The purpose of the Output Transformation policy is to 
perform any final transformation necessary on XML documents sent to the driver by Identity 
Manager and returned to the driver by Identity Manager. The Output Transformation policy is 
implemented as an XSLT style sheet.

The Output Transformation policy reverses the logic of the Input Transformation policy. The default 
driver configuration includes templates that complete the following actions:

Transforms Postal Address from structure syntax to string syntax. 
Returns telephone numbers to string format. 
Removes Class code from non-Person object associations.

The Publisher Placement Policy

The Publisher Placement policy is applied to an Add Object event document to determine the 
placement of the new object in the hierarchical structure of eDirectory. Only the Publisher channel 
utilizes the Placement policy.

personalTitle Other title P0002:NAMZU:none:189:15

preferredName Known As P0002:RUFNM:none:234:25

workforceID Personnel Number P0002:PERNR:none:0:8

eDirectory Attribute SAP Attribute Description SAP Attribute
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The Placement policy uses the employeeStatus attribute value and the values of driver object 
placement Global Configuration Values (GCVs) to place objects in specified eDirectory containers.

The Publisher Matching Policy

The Publisher Matching policy is applied to a modify object event document. Matching policies 
establish links between an existing entry in eDirectory and an existing entry in the SAP system. The 
Matching policy attempts to find an existing object that matches the object generating the event by 
the criteria specified in the policy. 

The default driver checks for matches based primarily on the workforceID attribute. A secondary 
rule is provided to attempt matching by Surname and Given Name values.

The Publisher Creation Policy

The Publisher Creation policy is applied when a new object is to be added to eDirectory. The 
Creation policy is implemented using both Policy Builder and XSLT style sheets.

The default driver configuration has Creation policies for the following:

Organizational Unit (if a Description attribute is present).
Creates a name for the object based on its Description.
Creates the OU attribute.

Organizational Role Object (if a Description attribute is present).
Creates a name for the object based on its Description.
Creates the CN attribute.

CommExec Object (if Description attribute is present).
Creates a name for the object based on its Description.
Creates the CN attribute.

User Object (the Surname and Given Name are transferred).
Generates an object name based on Given Name and Surname.
Sets initial password to the user’s Surname.

The Publisher Command Transformation Policy

The Publisher Command Transformation policy is used to apply any remaining business logic to 
event documents received from the driver. The default driver performs the following 
transformations:

Creates and maintains User object Manager and Direct Reports organizational relationships.
Sets Login Disabled attribute based on employee status.
Maintains proper Group Membership to an Employee or Manager group based on a User’s 
position, employee status, and GCV group name values.
Handles placement of User objects in Active or Inactive containers based on employee status 
and GCV user placement values.
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7.1.2  Using the Relationship Query
The SAP HR system is a relational database. Individual HR objects, such as the Person object, do 
not contain all of the information that is typically needed to describe the function of the Person 
within an organization. Organizational and Position information is contained in different objects that 
are related to the Person object for a specified period of time. The name of a Position a Person holds, 
the name of the Organization he belongs to, and the Organizational hierarchy to which a person 
belongs can only be determined by traversing the various relationships between objects.

The SAP driver has a special capability that allows a query to be made for the object relationships 
between an SAP object being processed in the Publisher channel and other SAP objects. This 
information is contained in Infotype 1001 (Object relationships) in the HRMD_A IDoc. (The 
documentation for the meaning of the various fields of this Infotype can be found on the SAP system 
using transaction WE60.) Because this relationship information cannot be easily mapped to 
eDirectory attributes, and because namespace attributes are stripped out of XML documents during 
various phases of processing, the capability to query for the pseudo-class RELATIONSHIPS was 
built into the driver.

The Relationship Query uses two different forms described below.

Query 1

This query uses the class identifier of the last object sent by the driver to the engine. In the context of 
the driver’s default configuration, this query provides accurate results for obtaining relationship data 
from Position objects as they are processed.

<nds dtdversion=”1.0” ndsversion="8.5">
  <input>
     <query class-name="RELATIONSHIPS" event-id="0"   
      scope="entry">
        <association>50000354</association>
     </query>
  </input>
</nds>

Query 2

This query utilizes the <search-class> element to specify the class of the object from which 
relationship data is desired. The driver combines the value of the element with the association to 
identify the proper relationship vector to return. This allows the policies to obtain relationship data 
from any object in the current IDoc being processed. The new default driver configuration contains 
queries of this type to provide working examples.

<nds dtdversion="1.0" ndsversion="8.5">
  <input>
     <query class-name="RELATIONSHIPS" event-id="0"
      scope="entry">
         <association>50000354</association> 
         <search-class class-name="S"/>
     </query>
   </input>
</nds>
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The driver has been modified to allow the return of all relationship information in a structured 
<value> format. This has been done to allow the style sheets to utilize any relationship data that is 
desired for implementing business rules. It is the responsibility of the configuration expert to 
determine which data is utilized, including time stamp information. The driver returns all requested 
fields in the 1001 (Relationships) infotype that contain a value. If a field is not populated or present, 
it is not returned. A sample of a reply to the RELATIONSHIPS Query 2 is presented below:

<nds dtdversion="1.0" ndsversion="8.5">
   <source>
<product build="INVALID_BUILD_ID" instance="SAP-HR" version="1.0.2">Identity 
Manager Driver for SAP/HR</product>
   <contact>Novell, Inc.</contact>
    </source>
     <output>      <instance class-name="RELATIONSHIPS" timestamp="20030529" 
xmlns:sapshim="http://www.novell.com/dirxml/drivers/SAPShim">
            <association>50000354</association>
            <sapshim:policyAttr attr-name="RELATIONSHIPS">
             <value type="structured">
                <component name="ITXNR">00000000</component>
                <component name="BEGDA">20020225</component>
                <component name="INFTY">1001</component>
                <component name="SEQNR">000</component>
                <component name="ISTAT">1</component>
                <component name="OTYPE">S</component>
                <component name="RELAT">003</component>
                <component name="ENDDA">99991231</component>
                <component name="SCLAS">O</component>
                <component name="PLVAR">01</component>
                <component name="MANDT">001</component>
                <component name="UNAME">NOVADM</component>
                <component name="RSIGN">A</component>
                <component name="SOBID">50000127</component>
                <component name="OBJID">50000354</component>
                <component name="VARYF">O 50000127</component>
                <component name="AEDTM">20020225</components>
             </value>
             <value type="structured">
                <component name="ITXNR">00000000</component>
                <component name="BEGDA">20020225</component>
                <component name="INFTY">1001</component>
                <component name="SEQNR">000</component>
                <component name="ISTAT">1</component>
                <component name="OTYPE">S</component>
                <component name="RELAT">005</component>
                <component name="ENDDA">99991231</component>
                <component name="SCLAS">S</component>
                <component name="PLVAR">01</component>
                <component name="MANDT">001</component>
                <component name="UNAME">NOVADM</component>
                <component name="RSIGN">A</component>
                <component name="SOBID">50000485</component>
                <component name="OBJID">50000354</component>
                <component name="VARYF">S 50000485</component>
                   <component name="AEDTM">20020301</component>
                 </value>
                 <value type="structured">
                   <component name="ITXNR">00000000</component>
                   <component name="BEGDA">20020225</component>
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                   <component name="INFTY">1001</component>
                   <component name="SEQNR">000</component>
                   <component name="ISTAT">1</component>
                   <component name="OTYPE">S</component>
                   <component name="RELAT">007</component>
                   <component name="ENDDA">99991231</component>
                   <component name="SCLAS">C</component>
                   <component name="PLVAR">01</component>
                   <component name="MANDT">001</component>
                   <component name="UNAME">NOVADM</component>
                   <component name="RSIGN">B</component>
                   <component name="SOBID">50000144</component>
                   <component name="OBJID">50000354</component>
                   <component name="VARYF">C 50000144</component>
                   <component name="AEDTM">20020225</component>
                   </value>
            </sapshim:policyAttr>
          </instance>
        </output>
      </nds>

The <read-attr> implementation of the driver RELATIONSHIPS query has been modified as 
follows:

The lack of a <read-attr> element implies a request to return all components of each matching 
relationship value.
An empty <read-attr/> element specifies that no values will be returned. This is a useless 
operation that is not recommended.
<read-attr> elements with attr-name attribute values indicate which specific component values 
are desired for each matching relationship value.

The <search-attr> functionality of the XDS DTD has been added to the driver RELATIONSHIP 
query. This enables queries for relationships matching more exacting criteria to reduce the quantity 
and type of reply data. Multiple <search-attr> values are interpreted as a logical AND of the 
individual search components. The default Publisher Command Transformation policy has been 
modified to use the new capabilities of the driver.

The following example is from the set-roles-manager-attr template, used to retrieve the SOBID 
value from any relationship with an RSIGN value of A and an SCLAS value of S:

Query 3

<nds dtdversion="1.0" ndsversion="8.5">
 <input>
    <query class-name="RELATIONSHIPS" event-id="0" scope="entry">
      <association>
         <xsl:value-of select="$newRole-ID"/>
      </association>
      <search-class class-name="S"/>
      <search-attr attr-name="RSIGN">
          <value>A</value>
      </search-attr>
   <search-attr attr-name="SCLAS">
       <value>S</value>
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    </search-attr>
    <read-attr attr-name="SOBID"/>
  <query>
 </input>
</nds> 

Populating the Identity Vault with Organizational Data

In order to populate the Identity Vault with the organizational data, the existing data must be 
exported from SAP. To export your organization’s hierarchical data, perform the following steps 
before starting the driver:

1 From the SAP client, enter transaction code PFAL.
2 Insert the Object Type O for Organization objects.
3 Enter the organizations you want to export to the Identity Vault. You can choose to export one 

organization, a range of organizations, or all organizations.
If exporting a range of objects, under the Parallel Processing tab on the HR: ALE Distribution 
of HR Master Data screen, select a value of 100 or less at the Number of Object per Process 
prompt. This ensures that driver processing does not consume too much Java heap space.

4 Click Execute. Ensure that the status is set to Passed to Port Okay.
5 Repeat the above process for Object Type C for Job objects.
6 Repeat the above process for Object Type S for Position objects.

IMPORTANT: It is important that you export the objects in the order specified above. This 
ensures that the driver creates the correct relationships when users are imported into the 
Identity Vault.
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8Managing the Driver

The driver can be managed through Designer, iManager, or the DirXML® Command Line utility. 

Section 8.1, “Starting, Stopping, or Restarting the Driver,” on page 65
Section 8.2, “Using the DirXML Command Line Utility,” on page 66
Section 8.3, “Viewing Driver Versioning Information,” on page 66
Section 8.4, “Reassociating a Driver Set Object with a Server Object,” on page 71
Section 8.5, “Changing the Driver Configuration,” on page 72
Section 8.6, “Storing Driver Passwords Securely with Named Passwords,” on page 72
Section 8.7, “Adding a Driver Heartbeat,” on page 79

8.1  Starting, Stopping, or Restarting the Driver
Section 8.1.1, “Starting the Driver in Designer,” on page 65
Section 8.1.2, “Starting the Driver in iManager,” on page 65
Section 8.1.3, “Stopping the Driver in Designer,” on page 65
Section 8.1.4, “Stopping the Driver in iManager,” on page 65
Section 8.1.5, “Restarting the Driver in Designer,” on page 66
Section 8.1.6, “Restarting the Driver in iManager,” on page 66

8.1.1  Starting the Driver in Designer
1 Open a project in the Modeler, then right-click the driver line.
2 Select Live > Start Driver.

8.1.2  Starting the Driver in iManager
1 In iManager, click Identity Manager > Identity Manager Overview.
2 Browse to the driver set where the driver exists, then click Search.
3 Click the upper right corner of the driver icon, then click Start driver.

8.1.3  Stopping the Driver in Designer
1 Open a project in the Modeler, then right-click the driver line.
2 Select Live > Stop Driver.

8.1.4  Stopping the Driver in iManager
1 In iManager, click Identity Manager > Identity Manager Overview.
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2 Browse to the driver set where the driver exists, then click Search.
3 Click the upper right corner of the driver icon, then click Stop driver.

8.1.5  Restarting the Driver in Designer
1 Open a project in the Modeler, then right-click the driver line.
2 Select Live > Restart Driver.

8.1.6  Restarting the Driver in iManager
1 In iManager, click Identity Manager > Identity Manager Overview.
2 Browse to the driver set where the driver exists, then click Search.
3 Click the upper right corner of the driver icon, then click Restart driver.

8.2  Using the DirXML Command Line Utility
The DirXML Command Line utility provides command line access to manage the driver. This utility 
is not a replacement for iManager or Designer. The primary use of this utility is to allow you to 
create platform-specific scripts to manage the driver.

For example, you could create a shell script on Linux to check the status of the driver.   See 
Appendix A, “DirXML Command Line Utility,” on page 99 for detailed information about the 
DirXML Command Line utility. For daily tasks, use iManager or Designer. 

8.3  Viewing Driver Versioning Information
The Versioning Discovery tool only exists in iManager.

Section 8.3.1, “Viewing a Hierarchical Display of Versioning Information,” on page 66
Section 8.3.2, “Viewing the Versioning Information as a Text File,” on page 68
Section 8.3.3, “Saving Versioning Information,” on page 70

8.3.1  Viewing a Hierarchical Display of Versioning Information
1 To find your Driver Set object in iManager, click Identity Manager > Identity Manager 

Overview, then click Search.
2 In the Identity Manager Overview, click Information.
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You can also select Identity Manager Utilities > Versions Discovery, browse to and select the 
Driver Set object, then click OK.

3 View a top-level or unexpanded display of versioning information.

The unexpanded hierarchical view displays the following:
The eDirectoryTM tree that you are authenticated to
The Driver Set object that you selected
Servers that are associated with the Driver Set object
If the Driver Set object is associated with two or more servers, you can view Identity 
Manager information on each server.
Drivers 

4 View versioning information related to servers by expanding the server icon.
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The expanded view of a top-level server icon displays the following:
Last log time
Version of Identity Manager that is running on the server

5 View versioning information related to drivers by expanding the driver icon.

The expanded view of a top-level driver icon displays the following:
The driver name 
The driver module (for example, 
com.novell.nds.dirxml.driver.delimitedtext.DelimitedTextDriver) 

The expanded view of a server under a driver icon displays the following:
The driver ID 
The version of the instance of the driver running on that server

8.3.2  Viewing the Versioning Information as a Text File
Identity Manager publishes versioning information to a file. You can view this information in text 
format. The textual representation is the same information contained in the hierarchical view.

1 To find your Driver Set object in iManager, click Identity Manager > Identity Manager 
Overview, then click Search.

2 In the Identity Manager Overview, click Information.
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You can also select Identity Manager Utilities > Versioning Discovery, browse to and select 
the Driver Set object, then click Information.

3 In the Versioning Discovery Tool dialog box, click View.

The information is displayed as a text file in the Report Viewer window.
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8.3.3  Saving Versioning Information
You can save versioning information to a text file on your local or network drive.

1 To find the Driver Set object in iManager, click Identity Manager > Identity Manager 
Overview, then click Search.

2 In the Identity Manager Overview, click Information.
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You can also select Identity Manager Utilities > Versioning Discovery, browse to and select 
the Driver Set object, then click Information.

3 In the Versioning Discovery Tool dialog box, click Save As.

4 In the File Download dialog box, click Save.
5 Navigate to the desired directory, type a filename, then click Save.

Identity Manager saves the data to a text file.

8.4  Reassociating a Driver Set Object with a 
Server Object
The driver set object should always be associated with a server object. If the driver set is not 
associated with a server object, none of the drivers in the driver set can start.
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If the link between the driver set object and the server object becomes invalid, you see one of the 
following conditions:

When upgrading eDirectory your Identity Manager server, you get the error 
UniqueSPIException error -783.
No server is listed next to the driver set in the Identity Manager Overview window.
A server is listed next to the driver set in the Identity Manager Overview window, but the name 
is garbled text.

To resolve this issue, disassociate the driver set object and the server object, then reassociate them. 

1 In iManager click Identity Manager > Identity Manager Overview, then click Search to find the 
driver set object that the driver should be associated with.

2 Click the Remove server icon, then click OK.
3 Click the Add server icon, then browse to and select the server object.
4 Click OK.

8.5  Changing the Driver Configuration
If you need to change the driver configuration, Identity Manager allows you to make the change 
through iManager or Designer. 

To change the driver configuration in iManager:

1 Click Identity Manager > Identity Manager Overview, then click Search to search for the 
driver set that is associated with the driver.

2 Browse to the driver, then click the upper right corner of the driver icon.
3 Click Edit Properties.

To change the driver configuration in Designer:

1 Open a project in the Modeler, then right-click the driver line and select Properties.

8.6  Storing Driver Passwords Securely with 
Named Passwords
Identity Manager allows you to store multiple passwords securely for a particular driver. This 
functionality is referred to as Named Passwords. Each different password is accessed by a key, or 
name.

You can also use the Named Passwords feature to store other pieces of information securely, such as 
a user name.

To use a Named Password in a driver policy, you refer to it by the name of the password, instead of 
using the actual password, and the Metadirectory engine sends the password to the driver. The 
method described in this section for storing and retrieving Named Passwords can be used with any 
driver without making changes to the driver shim.

Section 8.6.1, “Using Designer to Configure Named Passwords,” on page 73
Section 8.6.2, “Using iManager to Configure Named Passwords,” on page 73
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Section 8.6.3, “Using Named Passwords in Driver Policies,” on page 75
Section 8.6.4, “Using the DirXML Command Line Utility to Configure Named Passwords,” on 
page 75

8.6.1  Using Designer to Configure Named Passwords
1 Right-click the driver object, then select Properties.
2 Select Named Password, then click New.

3 Specify the Name of the Named Password.
4 Specify the Display name of the Named Password.
5 Specify the Named Password, then re-enter the password.
6 Click OK twice.

8.6.2  Using iManager to Configure Named Passwords
1 Click Identity Manager > Identity Manager Overview, then click Search to search for the 

driver set that is associated with the driver.
2 In the Identity Manager Overview, click the upper right corner of the driver icon, then click 

Edit properties.
3 On the Modify Object page on the Identity Manager tab, click Named Passwords.

The Named Passwords page appears, listing the current Named Passwords for this driver. If 
you have not set up any Named Passwords, the list is empty.
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4 To add a Named Password, click Add, complete the fields, then click OK.

5 Specify a name, display name and a password, then click OK twice.
You can use this feature to store other kinds of information securely, such as a username.

6 Click OK to restart the driver and have the changes take effect.
7 To remove a Named Password, select the password name, then click Remove.

The password is removed without prompting you to confirm the action.
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8.6.3  Using Named Passwords in Driver Policies
“Using the Policy Builder” on page 75
“Using XSLT” on page 75

Using the Policy Builder

Policy Builder allows you to make a call to a Named Password. Create a new rule and select Named 
Password as the condition, then set an action depending upon if the Named Password is available or 
not available. 

1 In Designer, launch Policy Builder, right-click, then click New > Rule.
2 Specify the name of the rule, then click Next.
3 Select the condition structure, then click Next.
4 Select named password for the Condition.
5 Browse to and select the Named Password that is stored on the driver.

In this example, it is userinfo.
6 Select whether the Operator is available or not available.
7 Select an action for the Do field.

In this example, the action is veto.

The example indicates that if the userinfo Named Password is not available, then the event is vetoed.

Figure 8-1   A Policy Using Named Passwords

Using XSLT

The following example shows how a Named Password can be referenced in a driver policy on the 
Subscriber channel in XSLT:

<xsl:value-of 
select=”query:getNamedPassword($srcQueryProcessor,'mynamedpassword')”
xmlns:query=”http://www.novell.com/java/
com.novell.nds.dirxml.driver.XdsQueryProcessor/>

8.6.4  Using the DirXML Command Line Utility to Configure 
Named Passwords

“Creating a Named Password in the DirXML Command Line Utility” on page 76
“Using the DirXML Command Line Utility to Remove a Named Password” on page 77
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Creating a Named Password in the DirXML Command Line Utility

1 Run the DirXML Command Line utility.
For information, see Appendix A, “DirXML Command Line Utility,” on page 99.

2 Enter your username and password.
The following list of options appears.
DirXML commands

 1: Start driver
 2: Stop driver
 3: Driver operations...
 4: Driver set operations...
 5: Log events operations...
 6: Get DirXML version

 7: Job operations...
99: Quit

Enter choice:

3 Enter 3 for driver operations.
A numbered list of drivers appears.

4 Enter the number for the driver you want to add a Named Password to.
The following list of options appears.
Select a driver operation for:
driver_name

 1: Start driver
 2: Stop driver
 3: Get driver state
 4: Get driver start option
 5: Set driver start option
 6: Resync driver
 7: Migrate from application into DirXML
 8: Submit XDS command document to driver

 9: Submit XDS event document to driver

10: Queue event for driver
11: Check object password
12: Initialize new driver object
13: Passwords operations
14: Cache operations
99: Exit

Enter choice:

5 Enter 13 for password operations.
The following list of options appears.
Select a password operation

 1: Set shim password
 2: Reset shim password

 3: Set Remote Loader password

 4: Clear Remote Loader password
 5: Set named password
 6: Clear named password(s)
 7: List named passwords
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 8: Get passwords state
99: Exit

Enter choice:

6 Enter 5 to set a new Named Password.
The following prompt appears:
Enter password name:

7 Enter the name by which you want to refer to the Named Password.
8 Enter the actual password that you want to secure at the following prompt:

Enter password:

The characters you type for the password are not displayed.
9 Confirm the password by entering it again at the following prompt:

Confirm password:

10 After you enter and confirm the password, you are returned to the password operations menu.
11 After completing this procedure, you can use the 99 option twice to exit the menu and quit the 

DirXML Command Line Utility.

Using the DirXML Command Line Utility to Remove a Named Password

This option is useful if you no longer need Named Passwords that you previously created.

1 Run the DirXML Command Line utility.
For information, see Appendix A, “DirXML Command Line Utility,” on page 99.

2 Enter your username and password.
The following list of options appears.
DirXML commands

 1: Start driver
 2: Stop driver
 3: Driver operations...
 4: Driver set operations...
 5: Log events operations...
 6: Get DirXML version

 7: Job operations
99: Quit

Enter choice:

3 Enter 3 for driver operations.
A numbered list of drivers appears.

4 Enter the number for the driver you want to remove Named Passwords from.
The following list of options appears.
Select a driver operation for:
driver_name
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 1: Start driver
 2: Stop driver
 3: Get driver state
 4: Get driver start option
 5: Set driver start option
 6: Resync driver
 7: Migrate from application into DirXML
 8: Submit XDS command document to driver

 9: Submit XDS event document to driver

10: Queue event for driver
11: Check object password
12: Initialize new driver object
13: Passwords operations
14: Cache operations
99: Exit

Enter choice:

5 Enter 13 for password operations.
The following list of options appears.
Select a password operation

 1: Set shim password
 2: Reset shim password

 3: Set Remote Loader password

 4: Clear Remote Loader passwor
 5: Set named password
 6: Clear named password(s)
 7: List named passwords

 8: Get passwords state
99: Exit

Enter choice:

6 (Optional) Enter 7 to see the list of existing Named Passwords.
The list of existing Named Passwords is displayed.
This step can help you make sure you are removing the correct password.

7 Enter 6 to remove one or more Named Passwords.
8 Enter No to remove a single Named Password at the following prompt:

Do you want to clear all named passwords? (yes/no):

9 Enter the name of the Named Password you want to remove at the following prompt:
Enter password name:

After you enter the name of the Named Password you want to remove, you are returned to the 
password operations menu:
Select a password operation

 1: Set shim password
 2: Reset shim password

 3: Set Remote Loader password

 4: Clear Remote Loader password
 5: Set named password
 6: Clear named password(s)
 7: List named passwords
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 8: Get passwords state
99: Exit

Enter choice:

10 (Optional) Enter 7 to see the list of existing Named Passwords.
This step lets you verify that you have removed the correct password.

11 After completing this procedure, you can use the 99 option twice to exit the menu and quit the 
DirXML Command Line utility.

8.7  Adding a Driver Heartbeat
The driver heartbeat is a feature of the Identity Manager drivers that ship with Identity Manager 2 
and later. Its use is optional. The driver heartbeat is configured by using a driver parameter with a 
time interval specified. If a heartbeat parameter exists and has an interval value other than 0, the 
driver sends a heartbeat document to the Metadirectory engine if there is no communication on the 
Publisher channel for the specified interval of time.

The intent of the driver heartbeat is to give you a trigger to allow you to initiate an action at regular 
intervals, if the driver does not communicate on the Publisher channel as often as you want the 
action to occur. To take advantage of the heartbeat, you must customize your driver configuration or 
other tools. The Metadirectory engine accepts the heartbeat document but does not take any action 
because of it. 

For most drivers, a driver parameter for heartbeat is not used in the sample configurations, but you 
can add it.

A custom driver that is not provided with Identity Manager can also provide a heartbeat document, 
if the driver developer has written the driver to support it.

To configure the heartbeat:

1 In iManager, click Identity Manager > Identity Manager Overview. 
2 Browse to and select your driver set object, then click Search.
3 In the Identity Manager Overview, click the upper right corner of the driver icon, then click 

Edit properties.
4 On the Identity Manager tab, click Driver Configuration, scroll to Driver Parameters, then 

look for Heart Beat or a similar display name.
If a driver parameter already exists for heartbeat, you can change the interval and save the 
changes, and configuration is then complete. 
The value of the interval cannot be less than 1. A value of 0 means the feature is turned off.
The unit of time is usually minutes; however, some drivers might choose to implement it 
differently, such as using seconds. 

5 If a driver parameter does not exist for heartbeat, click Edit XML.
6 Add a driver parameter entry like the following example, as a child of <publisher-options>. 

<pub-heartbeat-interval display-name="Heart Beat">10</pub-heartbeat-
interval>
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If the driver does not produce a heartbeat document after being restarted, check the placement 
of the driver parameter in the XML.

7 Save the changes, and make sure the driver is stopped and restarted.

After you have added the driver parameter, you can edit the time interval by using the graphical 
view. Another option is to create a reference to a global configuration value (GCV) for the time 
interval. Like other global configuration values, the driver heartbeat can be set at the driver set level 
instead of on each individual driver object. If a driver does not have a particular global configuration 
value, and the driver set object does have it, the driver inherits the value from the driver set object.
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9Synchronizing Objects

This section explains driver and object synchronization in DirXML® 1.1a, Identity Manager 2.0, 
and Identity Manager 3.x. Driver synchronization was not available for DirXML 1.0 and DirXML 
1.1.

After the driver is created, instead of waiting for objects to be modified or created, the data between 
the two connected systems can be sent through the synchronization process.

Section 9.1, “What Is Synchronization?,” on page 81
Section 9.2, “When Is Synchronization Done?,” on page 81
Section 9.3, “How Does the Metadirectory Engine Decide Which Object to Synchronize?,” on 
page 82
Section 9.4, “How Does Synchronization Work?,” on page 83

9.1  What Is Synchronization?
The actions commonly referred to as “synchronization” in Identity Manager refer to several different 
but related actions:

Synchronization (or merging) of attribute values of an object in the Identity Vault with the 
corresponding attribute values of an associated object in a connected system. 
Migration of all Identity Vault objects and classes that are included in the filter on the 
Subscriber channel. 
Generation of the list of objects to submit to the driver’s Subscriber channel for 
synchronization or migration in response to a user request (a manual synchronization). 
Generation of the list of objects to submit to the driver’s Subscriber channel for 
synchronization or migration in response to enabling a formerly disabled driver, or in response 
to a cache error.

9.2  When Is Synchronization Done?
The Metadirectory engine performs object synchronization or merging in the following 
circumstances:

A <sync> event element is submitted on the Subscriber or Publisher channel.
A <sync> event element is submitted on the Subscriber channel in the following 
circumstances:

The state of the object’s association value is set to “manual” or “migrate.” (This causes an 
eDirectoryTM event, which in turn causes the Identity Manager caching system to queue an 
object synchronization command in the affected driver’s cache.) 
An object synchronization command is read from the driver’s cache. 
Synchronizing Objects 81



82 Identit

novdocx (en)  17 S
eptem

ber 2009
A <sync> event element is submitted on the Publisher channel in the following circumstances:
A driver submits a <sync> event element. No known driver currently does this. 
The Metadirectory engine submits a <sync> event element for each object found as the 
result of a migrate-into-NDS query. These <sync> events are submitted using the 
Subscriber thread, but are processed using the Publisher channel filter and policies.

An <add> event (real or synthetic) is submitted on a channel and the channel Matching policy 
finds a matching object in the target system. 
An <add> event with an association is submitted on the Subscriber channel. This normally 
occurs only in exceptional cases, such as the bulk load of objects into eDirectory with 
DirXML-Associations attribute values. 
An <add> event is submitted on the Publisher channel and an object is found in eDirectory that 
already has the association value reported with the <add> event.

The Metadirectory engine generates synchronization requests for zero or more objects in the 
following cases:

The user issues a manual driver synchronization request. This corresponds to the Resync button 
in the Driver Set property page in ConsoleOne®, or to the Synchronize button on the iManager 
Identity Manager Driver Overview page.
The Metadirectory engine encounters an error with the driver’s cache and cannot recover from 
the cache error. The driver’s cache is deleted and the engine generates object synchronization 
commands as detailed in Section 9.3, “How Does the Metadirectory Engine Decide Which 
Object to Synchronize?,” on page 82.

9.3  How Does the Metadirectory Engine Decide 
Which Object to Synchronize?
The Metadirectory engine processes both manually initiated and automatically initiated 
synchronization requests in the same manner. The only difference in the processing of manually 
initiated versus automatically initiated driver synchronization requests is the starting filter time used 
to filter objects being considered for synchronization.

The starting filter time is used to filter objects that have modification or creation times that are older 
than the starting time specified in the synchronization request.

For automatically initiated driver synchronization, the starting filter time is obtained from the time 
stamps of cached eDirectory events. In particular, the starting filter time is the earliest time for the 
cached events that haven’t yet been successfully processed by the driver’s Subscriber channel.

For manually initiated driver synchronization, the default starting filter time is the earliest time in 
the eDirectory database. In Identity Manager 2 and Identity Manager 3, an explicit starting filter 
time can also be set. In DirXML 1.1a there is no facility to set the starting filter time value for 
synchronization when manually initiating driver synchronization.

The Metadirectory engine creates a list of objects to be synchronized on the Subscriber channel in 
the following manner:

1. It finds all objects that: 
Have an entry modification time stamp greater than or equal to the starting filter time
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and
Exist in the filter on the Subscriber channel.

2. It finds all objects that have an entry creation time stamp greater than or equal to the starting 
filter time. 

3. It adds a synchronize object command to the driver cache for each unique object found 
that has an entry modification time stamp greater than or equal to the starting filter time and all 
objects and classes that are in the Subscriber filter channel in the driver being synchronized.

9.4  How Does Synchronization Work?
After the Metadirectory engine determines that an object is to be synchronized, the following 
processes occur:

1. Each system (the Identity Vault and the connected system) is queried for all attribute values in 
the appropriate filters.

eDirectory is queried for all values in the Subscriber filter, and for values that are marked 
for synchronization in Identity Manager 2.x and Identity Manager 3.x. 
The connected system is queried for all values in the Publisher filter, and for values that 
are marked for synchronization in Identity Manager 2.x and Identity Manager 3.x.

2. The returned attribute values are compared and modification lists are prepared for the Identity 
Vault and the connected system according to Table 9-1 on page 84, Table 9-2 on page 85, and 
Table 9-3 on page 87.
In the tables the following pseudo-equations are used: 

“Left = Right” indicates that the left side receives all values from the right side. 
“Left = Right[1]” indicates that the left side receives one value from the right side. If there 
is more than one value, it is indeterminate. 
“Left += Right” indicates that the left side adds the right side values to the left side’s 
existing values. 
“Left = Left + Right” indicates that the left sides receives the union of the values of the left 
and right sides.

There are three different combinations of selected items in the filter, and each one creates a different 
output.

Section 9.4.1, “Scenario One,” on page 83
Section 9.4.2, “Scenario Two,” on page 85
Section 9.4.3, “Scenario Three,” on page 86

9.4.1  Scenario One
The attribute is set to Synchronize on the Publisher and Subscriber channels, and the merge authority 
is set to Default.
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Figure 9-1   Scenario One

The following table contains the values that the Metadirectory engine synchronizes when the 
attribute is sent through a filter that is set to the configuration for Scenario One. The table shows 
different outputs depending upon whether the attribute comes from the Identity Vault or the 
Application, if the attribute is single-valued or multi-valued, and if the attribute is empty or non-
empty.

Table 9-1   Output of Scenario One

Identity Vault
single-valued
empty

Identity Vault
single-valued
non-empty

Identity Vault
multi-valued
empty

Identity Vault
multi-valued
non-empty

Application
single-valued 
empty  

No change App = Identity Vault No change App = Identity 
Vault[1]

Application
single-valued 
non-empty  

Identity Vault = App App = Identity Vault Identity Vault = App Identity Vault + = 
App

Application
multi-valued 
empty  

No change App = Identity Vault No change App = Identity Vault

Application
multi-valued
non-empty  

Identity Vault = 
App[1]

App + = Identity 
Vault

Identity Vault = App App = App + 
Identity Vault

Identity Vault = App 
+ Identity Vault
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9.4.2  Scenario Two
The attribute is set to Synchronize only on the Subscriber channel, or it is set to Synchronize on both 
the Subscriber and Publisher channels. The merge authority is set to Identity Vault.

Figure 9-2   Scenario Two

The following table contains the values that the Metadirectory engine synchronizes when the 
attribute is sent through a filter that is set to the configuration for Scenario Two. The table shows 
different outputs depending upon whether the attribute comes from the Identity Vault or the 
Application, if the attribute is single-valued or multi-valued, and if the attribute is empty or non-
empty.

Table 9-2   Output of Scenario Two

Identity Vault
single-valued
empty

Identity Vault
single-valued
non-empty

Identity Vault
multi-valued
empty

Identity Vault
multi-valued
non-empty

Application
single-valued
empty  

No change App = Identity Vault No change App = Identity 
Vault[1]

Application
single-valued
empty  

App = empty App = Identity Vault Identity Vault = App App = Identity 
Vault[1]

Application
multi-valued
empty  

No change App = Identity Vault No change App = Identity Vault
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9.4.3  Scenario Three
The attribute is set to Synchronize on the Publisher channel or the merge authority is set to 
Application.

Figure 9-3   Scenario Three

The following table contains the values that the Metadirectory engine synchronizes when the 
attribute is sent through a filter that is set to the configuration for Scenario Three. The table shows 
different outputs depending upon whether the attribute comes from the Identity Vault or the 
Application, if the attribute is single-valued or multi-valued, and if the attribute is empty or non-
empty.

Application
multi-valued
non-empty  

App = empty App = Identity Vault App = empty App = Identity Vault

Identity Vault
single-valued
empty

Identity Vault
single-valued
non-empty

Identity Vault
multi-valued
empty

Identity Vault
multi-valued
non-empty
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Table 9-3   Output of Scenario Three

Identity Vault
single-valued
empty

Identity Vault
single-valued
non-empty

Identity Vault
multi-valued
empty

Identity Vault
multi-valued
non-empty

Application
single-valued
empty  

No change Identity Vault = 
empty

No change Identity Vault = 
empty

Application
single-valued
non-empty  

Identity Vault = App Identity Vault = App Identity Vault = App  Identity Vault = 
App

Application
multi-valued
empty  

No change Identity Vault = 
empty

No change Identity Vault = 
empty

Application
multi-valued non-
empty  

Identity Vault = 
App[1]

Identity Vault = 
App[1]

Identity Vault = App Identity Vault = App
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10Troubleshooting the Driver

This section contains potential problems and error codes you might encounter while configuring or 
using the driver. 

“Driver Load Errors” on page 89
“Driver Initialization Errors” on page 90
“Error connecting to SAP host” on page 90
“Attribute Mapping Error” on page 91
“Changes in SAP Do Not Generate an IDoc/Change Document” on page 91
“The Driver Does Not Recognize IDocs in the Directory” on page 91
“IDocs Are Not Written to the Directory” on page 91
“The Driver Does Not Authenticate to SAP” on page 92
“JCO Installation and Configuration Errors” on page 92
“Error When Mapping Drives to the IDoc Directory” on page 92
“Driver Configured as “Publisher-only” Still Tries to Connect to the SAP System” on page 93

10.1  Using the DSTrace Utility
You can troubleshoot the driver using the DSTrace utility. You should configure the utility’s options 
by selecting Edit > Properties > Identity Manager Drivers.

For each event or operation received, the driver returns an XML document containing a status 
report. If the operation or event is not successful, the status report also contains a reason and a text 
message describing the error condition. If the result is fatal, the driver shuts down.

After you have configured the DSTrace Utility, you can monitor your system for errors.

10.1.1  Driver Load Errors
If the driver does not load, check DSTrace for the following error messages:

java.lang.ClassNotFoundException:com.novell.nds.dirxml.driver.SAPShim.
SAPDriver Shim

This is a fatal error that occurs when SAPShim.jar is not installed properly. Ensure that the file is in 
the proper location for either a local or Remote Loader configuration.

java.lang.ClassNotFoundException:com.novell.nds.dirxml.drivers.SAPShim.
SAPDriver Shim

This is a fatal error that occurs when the class name for the SAPShim.jar is incorrect. Ensure that 
the Java class name is set on the Driver Module tab in a local installation and that the -class 
parameter is set in a Remote Loader configuration.

The proper class name is com.novell.nds.dirxml.driver.SAPShim.SAPDriverShim
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10.1.2  Driver Initialization Errors
You might see the following driver initialization errors in the DSTrace utility. An explanation of the 
error is given along with recommended solutions. 

com/sap/mw/jco/JCO

This error occurs when the SAP Java Connector sapjco.jar file or the JCO native support libraries 
are not present or are improperly located.

Make sure the proper platform version of sapjco.jar is located in the same directory as 
SAPShim.jar.

Also check the JCO native support libraries to make sure they are present and properly configured. 
Use the JCO installation instructions for the appropriate platform.

no jRFC12 in java.library.path

This error occurs when the SAP Java Connector (JCO) native RFC12 support library is not present 
or is located improperly. Make sure the JCO native support libraries are present and configured 
properly. Use the JCO installation instructions for the appropriate platform.

/usr/jdk1.3.1/lib/sparc/libjRFC12.so:<classpath info>:fatal librfccm.so:open failed: 
No such file or directory

This error occurs when the SAP Java Connector (JCO) native RFC support library librfccm.so is 
not present or is improperly located. This sample error is from a Solaris system.

Make sure the JCO native support libraries are present and properly configured. Follow the JCO 
installation instructions for the appropriate platform.

com.novell.nds.dirxml.engine.VRDException

This error occurs when the SAP Java Connector (JCO) components cannot be located. This error 
generally occurs if the driver or Remote Loader has not been restarted after the JCO has been 
configured. Restart Novell® eDirectory™ if you are using a local configuration or restart the 
Remote Loader for a remote configuration.

Error connecting to SAP host

This error occurs when the SAP authentication or connection information is not configured properly. 
Ensure that the values for Authentication and Driver Parameters are correct for authentication to the 
SAP host system.

nsap-pub-directory parameter is not a directory

This error occurs when the Publisher IDoc Directory parameter in the Publisher Settings of the 
Driver Parameters does not specify a valid file system location. Ensure that this parameter specifies 
the directory on the SAP system configured in the SAP ALE subsystem for IDoc file output.
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No connection to remote loader

This error occurs when the Remote Loader connection parameter information is incorrect. Configure 
the proper connection information for the remote connection to the system where the Remote 
Loader is running.

Authentication handshake failed, Remote Loader message: “Invalid loader 
password.”

This error occurs when the Remote Loader password configured on the remote system does not 
match the Remote Loader password on the Driver object.

Set matching passwords for both remote loaders. In iManager, ensure that both the application 
password and Remote Loader passwords are set at the same time.

Authentication handshake failed: Received invalid driver object password

This error occurs when the driver password configured on the remote system does not match the 
Driver object password on the Driver object. To correct this, you should set both Driver object 
passwords identically. 

10.1.3  Attribute Mapping Error
If the Mapping policy Add Dialog contains no data for the APP (application properties of class 
mappings), the driver can not find the HRMD_A schema metafile.

You should ensure that the metafile directory and Master HR IDoc driver parameters are set to a 
valid file system location and contain the proper IDoc name. Validate that the metadata file for the 
configured IDoc type is in the file system location. For example, if Master HR IDoc is set to the 
default HRMD_A03, ensure that HRMD_A03.meta exists in the metafile directory.

10.1.4  Changes in SAP Do Not Generate an IDoc/Change 
Document
Ensure that the ALE and change pointer processes are configured properly, and that you have 
properly entered data. 

The proper way of inserting or changing data is through using the Edit > Create or Edit > Change 
menus. If an error or a change is entered by overwriting an existing record and saving it, the change 
document is not created.

10.1.5  The Driver Does Not Recognize IDocs in the Directory
Verify that the driver parameters contain the correct client number and proper IDoc directory. 

10.1.6  IDocs Are Not Written to the Directory
You should first test the ALE and IDoc interface. Refer to your SAP documentation for more 
information. 
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If the IDoc interface fails:

Using transaction WE21, ensure that the file port is configured properly. Validate the path to 
the directory and make sure the Transfer IDoc Immediately option button is selected.
Using transaction WE20, ensure that the appropriate file port is selected in the Partner Profile. 
Also, verify that it is on the outbound parameters of the receiving system.

If the IDoc interface succeeds:

Ensure the change pointers have been configured.
Ensure that the scheduled processes are not scheduled too closely together. For example, if one 
job is in process and another job begins, the second job might be cancelled because the first job 
is still running.

10.1.7  The Driver Does Not Authenticate to SAP
First ensure that you have configured all of the driver parameters and that the proper passwords have 
been entered. 

If you are using the Publisher Channel Only configuration of the driver, make sure you have entered 
the correct parameters. If you have previously used a Publish and Subscribe driver, make sure that 
all files have been replaced by the Publish-only files.

If you are running the driver remotely, make sure that the Remote Loader has been started before 
you start the driver.

10.1.8  JCO Installation and Configuration Errors 
For detailed instructions on using the JCO Test utility and analyzing error messages, refer to 
Section 6.4, “Using the SAP Java Connector Test Utility,” on page 48.

10.1.9  Error When Mapping Drives to the IDoc Directory 
You might see the following error in DS Trace if the IDoc directory parameter specifies an invalid 
local file system container or if it specifies a mapped drive on a remote system.

*** NDS Trace Utility - BEGIN Logging *** Fri Sep 13 15:45:59 2005

Identity Manager Log Event -------------------
    Driver = \FLIBBLE_TREE\n\Driver Set\SAP-HR
    Channel = publisher
    Status = fatal
    Message = <description>SAP Document Poller initialization failed: 
com.novell.nds.dirxml.driver.SAPShim.SAPDocumentPollerInitFailure: Specified 
Publisher IDoc Directory is invalid.</description>

*** NDS Trace Utility - END   Logging *** Fri Sep 13 15:46:31 2005

This error occurs because the Windows operating system service controls the rights of the local 
system, not the rights of a user. Thus, the local Windows system does not have rights to access any 
file resources outside of its own system, including the IDoc directory.
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10.1.10  Driver Configured as “Publisher-only” Still Tries to 
Connect to the SAP System
The driver is designed to use a connection to SAP even when it is configured as a Publisher-only 
driver. Part of the interface for the Publisher channel is the ability to respond to <query> requests 
from the Metadirectory engine. These queries can be generated by the engine itself (converting a 
<modify> event to an <add> event) or can be generated by a policy. If SAP connection parameters 
are present, the driver attempts to read attributes from the SAP system to respond to those queries. 
The driver always uses the data in a published IDoc as the primary source for responding to those 
queries, but if attributes in the Publisher filter are not present in the IDoc, the data obtained in read 
operations is used to fill in the missing data.

This connection also verifies the validity time stamps of desired infotypes during processing of 
future-dated event IDocs. This is an extremely critical function that should always be enabled if 
future-dated processing options are chosen in the driver configuration. Disabling this capability 
could result in the propagation of old or stale events that have been subsequently overridden.

If you don’t want a connection to the SAP server, you should configure the driver to Disable 
Publisher Channel Read access. In this situation, the IDoc data being processed is used as a 
completely authoritative source of reliable data.
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11Backing Up the Driver

You can use Designer or iManager to create an XML file of the driver. The file contains all of the 
information entered into the driver during configuration. If the driver becomes corrupted, the 
exported file can be imported to restore the configuration information.

IMPORTANT: If the driver has been deleted, all of the associations on the objects are purged. 
When the XML file is imported again, new associations are created through the migration process.

Not all server-specific information stored on the driver is contained in the XML file. Make sure this 
information is documented through the Doc Gen process in Designer. See “Documenting Projects” 
in the Designer 2.1 for Identity Manager 3.5.1.

Section 11.1, “Exporting the Driver in Designer,” on page 95
Section 11.2, “Exporting the Driver in iManager,” on page 95

11.1  Exporting the Driver in Designer
1 Open a project in Designer, then right-click the driver object.
2 Select Export to Configuration File.
3 Specify a unique name for the configuration file, browse to location where it should be saved, 

then click Save.
4 Click OK in the Export Configuration Results window.

11.2  Exporting the Driver in iManager
1 In iManager, select Identity Manager > Identity Manager Overview.
2 Browse to and select the driver set object, then click Search.
3 Click the driver icon.
4 Select Export in the Identity Manager Driver Overview window.
5 Browse to and select the driver object you want to export, then click Next.
6 Select Export all policies, linked to the configuration or not or select Only export policies that 

are linked to the configuration, depending upon the information you want to have stored in the 
XML file.

7 Click Next.
8 Click Save As, then click Save.
9 Browse and select a location to save the XML file, then click Save.

10 Click Finish.
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12Security: Best Practices

For information on how to secure the driver and the information it is synchronizing, see “Security: 
Best Practices” in the Novell Identity Manager 3.5.1 Administration Guide.
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ADirXML Command Line Utility 

The DirXML® Command Line utility allows you to use a command line interface to manage the 
driver. You can create scripts to manage the driver with the commands. 

The utility and scripts are installed on all platforms during the Identity Manager installation. The 
utility is installed to the following locations: 

Windows: \Novell\Nds\dxcmd.bat
NetWare®: sys:\system\dxcmd.ncf 
UNIX: /usr/bin/dxcmd

There are two different methods for using the DirXML Command Line utility:

Section A.1, “Interactive Mode,” on page 99
Section A.2, “Command Line Mode,” on page 108

A.1  Interactive Mode
The interactive mode provides a text interface to control and use the DirXML Command Line utility. 

1 At the console, enter dxcmd.
2 Enter the name of a user with sufficient rights to the Identity Manager objects, such as 

admin.novell.
3 Enter the user’s password.

4 Enter the number of the command you want to perform.
Table A-1 on page 100 contains the list of options and what functionality is available.

5 Enter 99 to quit the utility.

NOTE: If you are running eDirectoryTM 8.8 on UNIX or Linux*, you must specify the -host and -
port parameters. For example, dxcmd -host 10.0.0.1 -port 524. If the parameters are not 
specified, a jclient error occurs.

novell.jclient.JCException: connect (to address) 111 UNKNOWN ERROR
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By default, eDirectory 8.8 is not listening to localhost. The DirXML Command Line utility needs to 
resolve the server IP address or hostname and the port to be able to authenticate.

Table A-1   Interactive Mode Options

Figure A-1   Driver Options

Option Description

1: Start Driver Starts the driver. If there is more than one driver, each driver is listed 
with a number. Enter the number of the driver to start the driver.

2: Stop Driver Stops the driver. If there is more than one driver, each driver is listed 
with a number. Enter the number of the driver to stop the driver.

3: Driver operations Lists the operations available for the driver. If there is more than one 
driver, each driver is listed with a number. Enter the number of the driver 
to see the operations available. See Table A-2 on page 101 for a list of 
operations.

4: Driver set operations Lists the operations available for the driver set.

1: Associate driver set with server

2: Disassociate driver set from server

99: Exit

5: Log events operations Lists the operations available for logging events through Novell® Audit. 
See Table A-5 on page 105 for a description of these options.

6: Get DirXML version Lists the version of the Identity Manager installed.

7: Job operations Manages jobs created for Identity Manager.

99: Quit Exits the DirXML Command Line utility
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Table A-2   Driver Options

Options Description

1: Start driver Starts the driver.

2: Stop driver Stops the driver.

3: Get driver state Lists the state of the driver.

0 - Driver is stopped

1 - Driver is starting

2 - Driver is running

3 - Driver is stopping

4: Get driver start option Lists the current driver start option.

1 - Disabled

2 - Manual

3 - Auto

5: Set driver start option Changes the start option of the driver.

1 - Disabled 

2 - Manual

3 - Auto

99 - Exit

6: Resync driver Forces a resynchronization of the driver. It prompts 
for a time delay: Do you want to specify a minimum 
time for resync? (yes/no).

If you enter Yes, specify the date and time you want 
the resynchronization to occur: Enter a date/time 
(format 9/27/05 3:27 PM).

If you enter No, the resynchronization occurs 
immediately.

7: Migrate from application into DirXML Processes an XML document that contains a query 
command: Enter filename of XDS query document:

Create the XML document that contains a query 
command by using the Novell nds.dtd (http://
developer.novell.com/ndk/doc/dirxml/dirxmlbk/ref/
ndsdtd/query.html).

Examples: 

NetWare: sys:\files\query.xml

Windows: c:\files\query.xml

Linux: /files/query.xml
DirXML Command Line Utility 101
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8: Submit XDS command document to driver Processes an XDS command document:

Enter filename of XDS command document:

Examples: 

NetWare: sys:\files\user.xml

Windows: c:\files\user.xml

Linux: /files/user.xml

Enter name of file for response:

Examples: 

NetWare: sys:\files\user.log

Windows: c:\files\user.log

Linux: /files/user.log

9: Submit XDS event document to driver Processes an XDS event document:

Enter filename of XDS event document:

Examples:

NetWare: sys:\files\add.xml

Windows: c:\files\add.xml

Linux: /files/add.xml

10: Queue event for driver Adds and event to the driver queue

Enter filename of XDS event document:

Examples:

NetWare: sys:\files\add.xml

Windows: c:\files\add.xml

Linux: /files/add.xml

11: Check object password Validates that an object’s password in the 
connected system is associated with a driver. It 
matches the object’s eDirectory password 
(Distribution Password, used with Universal 
Password). 

Enter user name:

12: Initialize new driver object Performs an internal initialization of data on a new 
Driver object. This is only for testing purposes.

13: Password operations There are nine Password options. See Table A-3 
on page 103 for a description of these options.

14: Cache operations There are five Cache operations. See Table A-4 on 
page 104 for a descriptions of these options.

Options Description
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Figure A-2   Password Operations

Table A-3   Password Operations

99: Exit Exits the driver options.

Operation Description

1: Set shim password Sets the application password. This is the 
password of the user account you are using to 
authenticate into the connected system with.

2: Clear shim password Clears the application password.

3: Set Remote Loader password The Remote Loader password is used to control 
access to the Remote Loader instance. 

Enter the Remote Loader password, then confirm 
the password by typing it again. 

4: Clear Remote Loader password Clears the Remote Loader password so no Remote 
Loader password is set on the Driver object.

5: Set named password Allows you to store a password or other pieces of 
security information on the driver. See Section 8.6, 
“Storing Driver Passwords Securely with Named 
Passwords,” on page 72 for more information.

There are four prompts to fill in:

Enter password name: 

Enter password description:

Enter password:

Confirm password:

Options Description
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Figure A-3   Cache Operations

Table A-4   Cache Operations

6: Clear named passwords Clears a specified Named Password or all Named 
Passwords that are stored on the driver object: Do 
you want to clear all named passwords? (yes/no).

If you enter Yes, all Named Passwords are cleared. 
If you enter No, you are prompted to specify the 
password name that you want to clear.

7: List named passwords Lists all Named Passwords that are stored on the 
driver object. It lists the password name and the 
password description.

8: Get password state Lists if a password is set for:

Driver Object password

Application password

Remote loader password

The dxcmd utility allows you to set the Application 
password and the Remote Loader password. You 
cannot set the Driver Object password with this 
utility. It shows if the password has been set or not.

99: Exit Exits the current menu and takes you back to the 
Driver options.

Operation Description

1: Get driver cache limit Displays the current cache limit that is set for the 
driver.

2: Set driver cache limit Sets the driver cache limit in kilobytes. A value of 0 
is unlimited.

Operation Description
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Figure A-4   Log Event Operations

Table A-5   Log Events Operations

3: View cached transactions A text file is created with the events that are stored 
in cache. You can select the number of 
transactions to view.

Enter option token (default=0):

Enter maximum transactions records to return 
(default=1):

Enter name of file for response:

4: Delete cached transactions Deletes the transactions stored in cache.

Enter position token (default=0):

Enter event-id value of first transaction record 
to delete (optional):

Enter number of transaction records to delete 
(default=1):

99: Exit Exits the current menu and takes you back to the 
Driver options.

Operation Description

1: Set driver set log events Allows you to log driver set events through Novell 
Audit. There are 49 items you can select to log. See 
Table A-6 on page 106 for a list of these options.

Type the number of the item you want to log. After 
the items are selected, enter 99 to accept the 
selections.

2: Reset driver set log events Resets all of the log event options.

3: Set driver log events Allows you to log driver events through Novell 
Audit. There are 49 items to select to log. See 
Table A-6 on page 106 for a list of these options.

Type the number of the item you want to log. After 
the items are selected, enter 99 to accept the 
selections.

Operation Description
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Table A-6   Driver Set and Driver Log Events

4: Reset driver log events Resets all of the log event options.

99: Exit Exits the log events operations menu.

Options

1: Status success

2: Status retry

3: Status warning

4: Status error

5: Status fatal

6: Status other

7: Query elements

8: Add elements

9: Remove elements

10: Modify elements

11: Rename elements

12: Move elements

13: Add-association elements

14: Remove-association elements

15: Query-schema elements

16: Check-password elements

17: Check-object-password elements

18: Modify-password elements

19: Sync elements

20: Pre-transformed XDS document from shim

21: Post input transformation XDS document

22: Post output transformation XDS document

23: Post event transformation XDS document

24: Post placement transformation XDS document

25: Post create transformation XDS document

26: Post mapping transformation <inbound> XDS document

27: Post mapping transformation <outbound> XDS document

Operation Description
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28: Post matching transformation XDS document

29: Post command transformation XDS document

30: Post-filtered XDS document <Publisher>

31: User agent XDS command document

32: Driver resync request

33: Driver migrate from application

34: Driver start

35: Driver stop

36: Password sync

37: Password request

38: Engine error

39: Engine warning

40: Add attribute

41: Clear attribute

42: Add value

43: Remove value

44: Merge entire

45: Get named password

46: Reset Attributes

47: Add Value - Add Entry

48: Set SSO Credential

49: Clear SSO Credential

50: Set SSO Passphrase

51: User defined IDs

99: Accept checked items

Options
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Table A-7   Enter Table Title Here

A.2  Command Line Mode
The command line mode allows you to use script or batch files. Table A-8 on page 108 lists the 
different options that are available.

To use the command line options, decide which items you want to use and string them together.

Example: dxcmd -user admin.headquarters -host 10.0.0.1 -password n0vell -start 
test.driverset.headquarters

This example command starts the driver.

Table A-8   Command Line Options

Options Description

1: Get available job definitions Allows you to select an existing job.

Enter the job number:

Do you want to filter the job definitions by 
containment? Enter Yes or No

Enter name of the file for response:

Examples:

NetWare: sys:\files\user.log

Windows: c:\files\user.log

Linux: /files/user.log

2: Operations on specific job object Allows you to perform operations for a specific job.

Option Description

Configuration

-user <user name> Specify the name of a user with administrative 
rights to the drivers you want to test.

-host <name or IP address> Specify the IP address of the server where the 
driver is installed.

-password <user password> Specify the password of the user specified above.

-port <port number> Specify a port number, if the default port is not 
used.

-q <quiet mode> Displays very little information when a command is 
executed.

-v <verbose mode> Displays detailed information when a command is 
executed.
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-s <stdout> Writes the results of the dxcmd command to 
stdout.

-? <show this message> Displays the help menu.

-help <show this message> Displays the help menu.

Actions

-start <driver dn> Starts the driver.

-stop <driver dn> Stops the driver.

-getstate <driver dn> Shows the state of the driver as running or stopped.

-getstartoption <driver dn> Shows the startup option of the driver.

-setstartoption <driver dn> <disabled|manual|auto> 
<resync|noresync>

Sets how the driver starts if the server is rebooted. 
Sets whether the objects are to be resynchronized 
when the driver restarts.

-getcachelimit <driver dn> Lists the cache limit set for the driver.

-setcachelimit <driver dn> <0 or positive integer> Sets the cache limit for the driver.

-migrateapp <driver dn> <filename> Processes an XML document that contains a query 
command. 

Create the XML document that contains a query 
command by using the Novell nds.dtd (http://
www.novell.com/documentation/idm35/
index.html?page=/documentation/idm35/
policy_dtd/data/
dtdndsoverview.html#dtdndsoverview).

-setshimpassword <driver dn> <password> Sets the application password. This is the 
password of the user account you are using to 
authenticate into the connected system with.

-clearshimpassword <driver dn> <password> Clears the application password.

-setremoteloaderpassword <driver dn> 
<password>

Sets the Remote Loader password.

The Remote Loader password is used to control 
access to the Remote Loader instance. 

<clearremoteloaderpassword <driver dn> Clears the Remote Loader password.

Option Description
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-sendcommand <driver dn> <input filename> 
<output filename>

Processes an XDS command document.

Specify the XDS command document as the input 
file.

Examples: 

NetWare: sys:\files\user.xml

Windows: c:\files\user.xml

Linux: /files/user.log

Specify the output filename to see the results.

Examples: 

NetWare: sys:\files\user.log

Windows: c:\files\user.log

Linux: /files/user.log

-sendevent <driver dn> <input filename> Submits a document to the driver’s Subscriber 
channel, bypassing the driver cache. The 
document is processed ahead of anything that 
might be in the cache at the time of the submission. 
It also means that the submission fails if the driver 
is not running.

-queueevent <driver dn> <input filename> Submits a document to the driver’s Subscriber 
channel by queuing the document in the driver 
cache. The document gets processed after 
anything that might be in the cache at the time of 
the submission. The submission won’t fail if the 
driver isn’t running.

-setlogevents <dn> <integer ...> Sets Novell Audit log events on the driver. The 
integer is the option of the item to log. See Table A-
6 on page 106 for the list of the integers to enter.

-clearlogevents <dn> Clears all Novell Audit log events that are set on the 
driver.

-setdriverset <driver set dn> Associates a driver set with the server.

-cleardriverset Clears the driver set association from the server.

-getversion Shows the version of Identity Manager that is 
installed.

-initdriver object <dn> Performs an internal initialization of data on a new 
Driver object. This is only for testing purposes.

-setnamedpassword <driver dn> <name> 
<password> [description]

Sets Named Passwords on the driver object. You 
specify the name, the password, and the 
description of the Named Password.

-clearnamedpassword <driver dn> <name> Clears a specified Named Password.

-startjob <job dn> Starts the specified job.

Option Description
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If a command line is executed successfully, it returns a zero. If the command line returns anything 
other than zero, it is an error. For example 0 means success, and -641 means invalid operation. -641 
is an eDirectory error code. Table A-9 on page 111 contains other values for specific command line 
options.

Table A-9   Command Line Option Values

-abortjob <job dn> Aborts the specified job.

-getjobrunningstate <job dn> Returns the specified job’s running state.

-getjobenabledstate <job dn> Returns the specified job’s enabled state.

-getjobnextruntime <job dn> Returns the specified job’s next run time.

-updatejob <job dn> Updates the specified job.

-clearallnamedpaswords <driver dn> Clears all Named Passwords set on a specific 
driver.

Command Line Option Values

-getstate 0- stopped

1- starting

2- running

3- shutting down

11- get schema

Anything else that is returned is an error.

-getstartoption 0- disabled

1- manual

2- auto

Anything else that is returned is an error.

-getcachelimit 0- unlimited

Anything else that is returned is an error.

-getjobrunningstate 0- stopped

1- running

Anything else that is returned is an error.

-getjobenabledstate 0- disabled

1- enabled

2- configuration error

Anything else that is returned is an error.

Option Description
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-getjobnextruntime Return is the next scheduled time for the job in 
eDirectory time format (number of seconds since 
00:00:00 Jan 1, 1970UTC).

Command Line Option Values
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BExample XML Document Received 
from the Driver

The following example is a typical XML document that has been parsed from HRMD_A number 
O_200_0000000000008134.

<nds dtdversion="1.0" ndsversion="8.5">
     <source>
          <product build="20050916_0956" instance="SAP-HR" version 
"3.5">Identity Manager 
        Driver for SAP/HR</product>
        <contact>Novell, Inc.</contact>
     </source>
      <input xmlns:sapshim="http://www.novell.com/dirxml/drivers/SAPShim">
         <modify class-name="P" event-id="O_200_0000000000008134" src-    
            dn="00000049" timestamp="20011204-99991231">
                  <association>00000049</association>
                    <modify-attr attr-name="P0001:STELL:none:141:8">
                        <remove-all-values/>
                          <add-value>
                               <value timestamp="20011018-99991231">50000055</
value>
                         </add-value>
                    </modify-attr>
                    <modify-attr attr-name="P0000:STAT2:none:79:1">
                         <remove-all-values/>
                            <add-value>
                                 <value timestamp="20011018-99991231">3</value>
                            </add-value>
                    </modify-attr>
              <modify-attr attr-name="P0002:NACHN:none:84:25">
                           <remove-all-values/>
                           <add-value>
                                   <value timestamp="19960421-99991231">Jones</
value>
                            </add-value>
                    </modify-attr>
                    <modify-attr attr-name="P0002:VORNA:none:134:25">
                           <remove-all-values/>
                           <add-value>
                                  <value timestamp="19960421-99991231">Paul</
value>
                            </add-value>
                    </modify-attr>
                    <modify-attr attr-name="P0006:STRAS:1:103:30">
                           <remove-all-values/>
                           <add-value>
                                <value timestamp="20010101-99991231">123 Main 
Street</value>
                           </add-value>
                    </modify-attr>
              </modify>
        </input>
</nds>
Example XML Document Received from the Driver 113
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Some characteristics to note:

All XML documents received from the SAP HR system are translated into <modify> 
documents. This translation occurs because it is not possible to determine whether the object 
described by the document has been modified or is new. Additional modification or translation 
of the document is accomplished through policies and the Metadirectory engine.
The <modify> element contains the class-name of the object described (that is, P= Person). The 
event-id attribute contains the IDoc number from which the data is derived. The src-dn attribute 
contains the SAP Object ID value. The timestamp attribute contains the date that the IDoc was 
processed by the driver.
The <association> element data always contains the SAP Object ID.
The <modify-attr> element contains the attr-name described in SAP format (Segment:Attribute 
Name:SubType:Value Offset:Value Length).
Because multivalue attributes cannot be consistently mapped across systems, the <remove-all-
values> element is used prior to all <add-value> tags. This instructs the Metadirectory engine 
to remove all existing values for the attribute prior to assigning the new value. If this 
functionality is not desired, one of the XSLT policies may be used to modify the document.
The <value> element contains a timestamp attribute with the BEGIN VALIDITY-END 
VALIDITY time stamp of the attribute’s data segment (that is, Segment P001 data has a time 
stamp of 20011018-99991231). This means the data became valid on October 18, 2001 and 
remains valid to the SAP maximum date. All data segments might have different or future-
dated validity time stamps.
All values are in a string format.
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CDriver BAPIs

Table C-1 on page 115 contains a list of BAPIs used by the driver. The driver supports stale Infotype 
data checks for:

Infotype 0001 (providing there are no date gaps in validity dates of data rows)
Infotype 0002
Infotype 0006
Infotype 0105
Infotype 0032

It is not possible to do a stale data check on other Infotypes due to the lacke of support in the SAP 
BAPIs. The validity checking algorithm of the driver always return a valid status for these Infotypes.

Table C-1   Driver BAPIs

BAPI Name Description

BAPI_EMPLOYEE_CHECKEXISTENCE Used to check for the existence of an employee with a 
specified Personnel Number (PERNR.) Only used for queries 
with no <read-attr> elements.

BAPI_EMPLOYEE_ENQUEUE Used to lock employee records prior to Subscriber 
modifications.

BAPI_EMPLOYEE_DEQUEUE Used to unlock employee records after Subscriber 
modifications.

BAPI_EMPLOYEE_GETDATA Used to read an employee’s Organizational Assignment 
(Infotype P0001) records.

Used during processing of future-dated IDocs to verify that a 
key with the validity dates of Organizational Assignment 
instances in the IDoc still exists in the SAP server (stale data 
checking.)

BAPI_PERSDATA_GETLIST Used to obtain a list of keys for an employee’s Personal Data 
(Infotype P0002) records.

Used during processing of future-dated IDocs to verify that a 
key with validity dates of Personal Data instances in the IDoc 
still exists in the SAP server (stale data checking.)

BAPI_PERSDATA_GETDETAIL Used to read the current data field values of a specified 
instance of an employee Personal Data record.

BAPI_PERSDATA_CHANGE Used to modify the current data field values of a specified 
instance of an employee Personal Data record.
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BAPI_ADDRESSEMP_GETLIST Used to obtain a list of keys for an employee’s Address 
(Infotype P0006) records.

Used during processing of future-dated IDocs to verify that a 
key with the validity dates of Address instances in the IDoc 
still exists in the SAP server (stale data checking.)

BAPI_ADDRESSMP_GETDETAIL Used to read the current data field values of a specified 
instance of an employee Address record.

BAPI_ADDRESSMP_CHANGE Used to modify the current data field values of a specified 
instance of an employee Address record.

BAPI_EMPLCOMM_GETLIST Used to obtain a list of keys for an employee’s 
Communication (Infotype P0105) records. Used in SAP R/3 
versions 4.6 and later.

Used during processing of future-dated IDocs to verify that a 
key with the validity dates of Communication instances in the 
IDoc still exists in the SAP server (stale data checking.)

BAPI_EMPLCOMM_GETDETAIL Used to read the current data field value of a specified 
instance of an employee Communication record. Used in 
SAP R/3 versions 4.6 and later.

BAPI_EMPLCOMM_CHANGE Used to modify the current data field value of a specified 
instance of an employee Communication record. Used in 
SAP R/3 version 4.6 and later.

BAPI_EMPLCOMM_CREATE Used to create a new instance of an employee 
Communication record. Used in SAP R/3 version 4.6 and 
later.

BAPI_EMPLCOMM_DELIMIT Used to set the Ending validity period date of a current 
instance of an employee Communication record. Delimit 
always sets to the day prior to the current date. If the Starting 
validity date and the Ending date are the same, the record 
instance is deleted. Used in SAP R/3 versions 4.6 and later.

BAPI_EMPLCOMM_DELETE Used to delete the current instance of an employee 
Communication record. Used in SAP R/3 versions 4.6 and 
later.

BAPI_HRMASTER_SAVE_REPL_MULT Used to create or replace the current instance of an 
employee Communication record. Used in SAP R/3 version 
4.5.

BAPI_INTCONTROL_GETLIST Used to obtain a list of keys for an employee’s Internal 
Control Data (Infotype P0032) records.

Used during processing of future-dated IDocs to verify that a 
key with the validity dates of Internal Control Data in the IDoc 
still exists (stale data checking.)

BAPI_INTCONTROL_GETDETAIL Used to read the current data field value of a specified 
instance of an employee Internal Control Data record.

BAPI_INTCONTROL_CREATE Used to create a new instance of an employee Internal 
Control Data record.

BAPI Name Description
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BAPI_INTCONTROL_CHANGE Used to modify the current data field of a specified instance of 
an employee Internal Control Data record.

BAPI_INTCONTROL_DELIMIT Used to set the Ending validity period date of a current 
instance of an employee Internal Control Data record. Delimit 
always sets to the day prior to the current data. If the Starting 
validity period date and the Ending date are the same, the 
record instance is deleted. Used in SAP R/3 versions 4.6 and 
later.

BAPI_INTCONTROL_DELETE Used to delete the current instance of an employee Internal 
Control Data record.

BAPI Name Description
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DSubscriber Change Modes and 
Validity Date Modes

“Change Mode Notes” on page 119
“Validity Date Modes” on page 121

D.1  Change Mode Notes
The field name BEGDA indicates the Stating validity date of a value
The field name ENDDA indicates the Ending validity date of a value.
The term “active value” indicates a value that has a BEGDA less than or equal to the current 
date and an ENDDA greater than or equal to the current date.
Although the driver can handle multiple value synchronization of any particular 
Communication Subtype on either the Publisher or Subscriber channel, there are issues related 
to the IDocs generated by SAP value deletion/delimit events that make multiple value 
synchronization unadvised and unsupported by the Subscriber channel. It is recommended that 
only one value for each Communication subtype is maintained.
Because multiple fields are available in the Internal Control Data infotype, a remove-value 
operation does not result in the deletion of the record instance. The result is the removal of the 
specified field value form the record instance.
For Communication values (Infotype P0105), this new functionality is only available in SAP 
R/3 version 4.6A or later and on all Web Application Server versions. On 4.5 systems (no 
support prior to 4.5B) the driver uses the BAPI_HRMASTER_SAVE_REPL_MULT function 
for all operations. <remove-value> and <remove-all-value> operations remove all values of the 
specified Communication Subtype. <add-value> operations remove all values of the 
Communication Subtype and create a new value with a BEGDA of current date and an 
ENDDA of 99991231.
For Internal Control Data values (Infotype P0032), the DELIMIT mode is not available prior to 
SAP R/3 version 4.6A.

The following sections describe the driver’s behavior for each event type and change mode.

D.1.1  <remove-all-values> command
The following operations occur when a <remove-all-values/> element exists in a <modify-attr> 
command. This is a non-standard XDS Subscriber operation that is generate by a policy.

Delimit Mode

The driver obtains a list of all active values of the specified Infotype record. The driver delimits the 
validity of each instance (set ENDDA) to current date -1. This is the standard SAP delimitation 
method. If BEGDA is equal to the current date, the value is deleted. This is also standard 
functionality.
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Delete Mode

The driver obtains a list of all active values of the specified Infotype record and deletes each 
instance.

Change Mode

The driver obtains a list of all active values of the specified Infotype record and deletes each 
instance.

D.1.2  <remove-value> command without accompanying <add-
value>
The following operations occur when a <remove-value> element without an accompanying <add-
value> element exists in a <modify-attr> command. This is the format of a standard Subscriber 
value remove XDS event.

Delimit Mode

The driver obtains a list of all active values of the specified Infotype record. The driver tries to 
match the existing values to the removed value. If a match is found, the driver delimits the validity 
of the matching value to (current date -1.)

Delete Mode

The driver obtains a list of all active values of the specified Infotype record. The driver tries to 
match the existing values to the removed value. If a match is found, the driver deletes the matching 
value. 

Change Mode

The driver obtains a list of all active values of the specified Infotype record. The driver tries to 
match the existing values to the removed value. If a match is found, the driver deletes the matching 
value.

D.1.3  <remove-value> command with accompanying <add-
value>
The following operations occur when a <remove-value> element with an accompanying <add-
value> element exists in a <modify-attr> command. This is the format of a standard Subscriber 
value change XDS format.

Delimit Mode

The driver obtains a list of all active values of the specified Infotype record. The driver tries to 
match the existing values to the removed value. If a match is found, the driver delimits the validity 
of the matching value to (current date -1.) If the added value is not already an active value, the added 
value is created.
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Delete Mode

The driver obtains a list of all active values of the specified Infotype record. The driver tries to 
match the existing values to the removed value. If a match is found, the driver deletes the matching 
value. If the added value is not already an active value, the added value is created.

Change Mode

The driver obtains a list of all active values of the specified Infotype record. The driver tries to 
match the existing values to the removed value. If a match is found, the driver changes the matching 
value to the added value. If a match is not found, the driver deletes the removed value. If the added 
value is not already an active value, the added value is created.

D.1.4  <add-value> command without prior <remove-value>
If the added value is not already an active value, the driver creates the added Infotype for all modes.

NOTE: This new functionality is only available on SAP R/3 version 4.6A or later and on all Web 
Application Server versions. On 4.5 systems (no support prior to 4.5B) the driver uses the 
BAPI_HRMASTER_SAVE_REPL_MULT function for all operations. <remove-value> and 
<remove-all-value> operations remove all values of the specified Communication Subtype. <add-
value> operations remove all values of the Communication Subtype and create a new value with a 
BEGDA of (current date) and an ENDDA of 99991231.

D.2  Validity Date Modes
The driver contains configuration parameters that allow an administrator to specify how validity 
begin dates (BEGDA) and validity end dates (ENDDA) are set when new Communication or 
Internal Control Data values are created for an Employee object. The new parameters are 
Communication Validity Date Mode and Internal Data Validity Date Mode. They allow two modes 
of operation:

Current Date Mode

This mode configures the driver to set validity dates in the same manner employed by all other 
previous versions of the driver. The driver sets the current date for the validity begin field (BEGDA) 
and sets the maximum SAP date for the validity end field (ENDDA).

Default Mode

This mode configures the driver to not set any BEGDA and ENDDA field values. When these 
values are not set, the default validity dating scheme of the SAP server is used to set these two field 
values. Standard SAP configuration sets the BEGDA value to the date that the Employee record was 
created and sets the ENDDA value to the maximum SAP date value.
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